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BAØI TAÄP 1  

BAØI TOAÙN DAÀM LIEÂN TUÏC 
  

Trong baøi taäp naøy baïn seõ thöïc taäp tính toaùn moät daàm lieân tuïc. Daàm lieân tuïc thöôøng xuaát 
hieän moät trong nhöõng baøi toaùn veà caàu ñöôøng vôùi moâ hình döôùi ñaây : 

 
 Vôùi soá lieäu baøi toaùn ban ñaàu cuûa daàm nhö sau :  

� Daàm ñôn giaûn daøi 30 m chòu taûi troïng phaân boá hình thang  

� Vaät lieäu laø theùp vôùi moâ ñun ñaøn hoài: E= 1.99e8 KN/ m2 

� Heä soá Poisson v = 0.3. 

� Daàm laøm baèng theùp hình vôùi soá hieäu laø W21x50. 

1. KHÔÛI ÑOÄNG SAP 2000 

Ñeå giaûi baøi toaùn, ñaàu tieân baïn khôûi ñoäng Sap baèng caùch vaøo trình ñôn Start > Programs 
> SAP 2000 NonLinear > SAP 2000 Non Linear. 
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2. ÑÔN VÒ TÍNH  

      Nhaáp chuoät vaøo tam giaùc beân phaûi phaàn döôùi 
cuûa maøn hình ñeå thay ñoåi ñôn vò laø KN-m. 

 
3. TAÏO MOÂ HÌNH MAÃU 

Ñeå taïo moät moâ hình maãu veà daàm lieân tuïc ñaàu tieân baïn vaøo trình ñôn File > New Model 
from Template. 

 
 Hoäp thoaïi Model Template xuaát hieän : 

 
 Trong hoäp thoaïi Model Template ñeå choïn moät moâ hình maãu veà daàm lieân tuïc ñaàu tieân 
baïn duøng chuoät nhaáp vaøo kieåu ñaàu tieân nhö hình con troû chæ beân treân ñeå môû hoäp thoaïi Beam. 

Hoäp thoaïi Beam xuaát hieän : 

 
 Trong hoäp thoaïi Beam baïn tieán haønh khai baùo nhö sau : 
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� Nhaáp chuoät vaøo Restraints ñeå kích choïn ñieàu kieän raøng buoäc (lieân keát maëc 
ñònh) 

� Trong muïc Number of Spans (Soá nhòp) : 1 

� Taïi muïc Span Lingth (chieàu daøi cuûa moät nhòp) : 30 

� Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Beam. 

Baây giôø treân maøn hình xuaát hieän hai cöûa soå laøm vieäc ñoù laø 3-D View vaø X-Y Plan @Y=0 
khi ñoù baïn duøng chuoät nhaáp choïn vaøo nuùt Close ñeå ñoùng cöûa soå 3-D View nhö hình con troû chæ 
beân döôùi. 

 

 

Hình khi thöïc hieän 

4. PHAÂN CHIA DAÀM 

Ñeå chia daàm thaønh ba phaàn baèng nhau ñaàu tieân duøng chuoät nhaáp choïn daàm, sau ñoù vaøo 
trình ñôn Edit > Divide Frames. 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH  SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 11 

 

   
Hoäp thoaïi Divide Selected Frames xuaát hieän. 

 Trong hoäp thoaïi Divide Selected Frames baïn tieán haønh khai baùo cho daàm nhö sau : 

� Nhaáp chuoät vaøo Divide into (soá phaân ñoaïn caàn chia) sau ñoù nhaäp giaù trò laø : 3 

� Taïi muïc Last / First radio (Tyû leä chia) laø : 1 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Divide Selected Frames. 

 
Daàm ñöôïc chia thaønh ba phaàn 
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5. KHAI BAÙO ÑAËC TRÖNG VAÄT LIEÄU 

Baây giôø baïn seõ tieán haønh khai baùo vaät lieäu cho daàm baèng caùch vaøo trình ñôn Difine > 
Materials ñeå môû hoäp thoaïi Define Materials. 

 
Hoäp thoaïi Define Materials xuaát hieän : 

 
 Trong hoäp thoaïi Define Materials tröôùc tieân baïn duøng chuoät nhaáp choïn vaøo Steel sau 
ñoù nhaáp choïn vaøo Modify / Show Materials ñeå môû hoäp thoaïi Materials Property Data. 

 
 Trong hoäp thoaïi Materials Property Data baïn khai baùo nhö sau : 

• Modulus of elasticity (modul ñaøn hoài) nhaäp vaøo giaù trò laø 1.99e8. 

• Poissons radio (heä soá Poatxong) laø 0.3 

• Nhöõng giaù trò khaùc ñeå theo cheá ñoä maëc ñònh. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Materials Property Data 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Define Materials 
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6. KHAI BAÙO ÑAËC TRÖNG HÌNH HOÏC 

           Theo ñeà baøi ñaõ cho daàm ñöôïc laøm baèng 
theùp hình W21x50 vì vaäy baïn tieán haønh khai 
baùo nhö sau : Ñaàu tieân baïn vaøo trình ñôn 
Define > Frame Sections ñeå xuaát hieän hoäp 
thoaïi Define Frame Sections. 

 

 Hoäp thoaïi Define Frame Sections xuaát hieän : 

 
 Trong hoäp thoaïi Define Frame Sections baïn thöïc hieän theo trình töï sau: 

• Trong muïc Click to baïn duøng chuoät nhaáp vaøo tam giaùc beân phaûi cuûa tab ñaàu 
tieân sau ñoù di chuyeån thanh tröôït ñöùng ñeå choïn Import / Wide Flange khi ñoù 
xuaát hieän hoäp thoaïi Section Property File. 

 
 Trong hoäp thoaïi Section Property File baïn chæ ñöôøng daãn ñeán Sap2000n (trong muïc 
Look in) sau ñoù nhaáp choïn vaøo thö muïc Sections. Pro vaø choïn Open ñeå xuaát hieän 
c:\sap2000\sections.pro. 

 (Chuù yù “c”xuaát hieän ôû ñaây vì chöông trình sap2000n tröôùc ñaây caøi trong oå ñóa coù teân c) 
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 Hoäp thoaïi c:\sap2000\sections.pro 
xuaát hieän. 

Trong hoäp thoaïi c:\ sap2000 \ 
sections.pro taïi muïc sections Labels baïn 
duøng chuoät nhaán vaø giöõ chuoät vaøo thanh tröôït 
ñöùng beân phaûi ñeå choïn W21x50 sau ñoù nhaáp 
choïn OK ñeå xuaát hieän hoäp thoaïi I/Wide 
Flange Section. 

 

 
Hoäp thoaïi I/Wide Flange Section xuaát hieän. 

 

Trong hoäp thoaïi I/Wide Flange Section baïn nhaáp chuoät vaøo muïc Import ñeå xuaát hieän 
hoäp thoaïi c:\sap2000\sections.pro trôû laïi, baïn nhaáp chuoät vaøo thanh tröôït ñöùng beân phaûi ñeå 
choïn W21x50, choïn xong nhaáp OK. 
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Hoäp thoaïi Define Frame Sections xuaát hieän, baïn 
nhaáp choïn W21X50 vaø choïn OK ñeå ñoùng hoäp thoaïi. 

 
• Nhaáp choïn OK ñeå ñoùng muïc I/Wide Flange Section. 

Luùc baây giôø treân maøn hình xuaát hieän hoäp thoaïi Define Frame Sections coù teân W21x50 
maø baïn vöøa thöïc hieän, tieáp theo baïn nhaáp choïn OK ñeå ñoùng hoäp thoaïi Define Frame Sections. 

7. GAÙN ÑAËC TRÖNG CHO DAÀM 

Ñeå gaùn tieát dieän W21x50 cho toaøn boä daàm baïn thöïc hieän nhö sau :  

• Duøng chuoät nhaáp choïn 3 thanh daàm (khi ñöôïc choïn, hình daàm trôû thaønh nhöõng 
ñöôøng chaám chaám). 

 

 Tieáp theo vaøo trình ñôn Assign > Frame > Sections. 
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Hoäp thoaïi Define Frame Sections xuaát hieän. 

 

 Trong hoäp thoaïi Define Frame Sections taïi muïc Frame Sections baïn nhaáp choïn vaøo 
W21x50 sau ñoù nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Frame Sections. 

 

Hình khi thöïc hieän 

8. KHAI BAÙO TAÛI TROÏNG 

Khai baùo tröôøng hôïp taûi, ñaàu tieân baïn vaøo trình ñôn Define > Static Load Cases. 

 

Hoäp thoaïi Define Static Load Cases Names xuaát hieän. 
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 Trong hoäp thoaïi Define Static Load Cases Names taïi muïc Load baïn choïn tröôøng hôïp 
taûi laø LOAD 1, trong muïc Self Weight Multiplier (heä soá troïng löôïng baûn thaân) nhaäp vaøo giaù trò 
laø 0. Taïi hoäp Click to nhaáp chuoät vaøo Change Load ñeå thay ñoåi giaù trò vöøa nhaäp vaøo sau ñoù 
nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

9. KHAI BAÙO TAÛI PHAÂN BOÁ 

Taûi phaân boá cuûa daàm naøy goàm ba thaønh phaàn, ñeå khai baùo ñöôïc ba thaønh phaàn ñoù baïn tieán 
haønh thöïc hieän theo trình töï sau: 

� Nhaáp chuoät vaøo phaàn töû thöù nhaát (tính töø traùi sang phaûi) nhö hình con troû chæ beân döôùi 
(ñoaïn thaúng ñöùt khuùc). 

 
 Theo baøi toaùn ban ñaàu taûi phaân boá hình thang vì vaäy baïn vaøo trình ñôn Assign > Frame 
Static Loads > Trapezoidal. 
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Hoäp thoaïi Trapezoidal Span Loads xuaát hieän : 

 
 Trong hoäp thoaïi Trapezoidal Span Loads baïn khai baùo theo trình töï sau: 

� Taïi muïc Load Case Name nhaán vaø giöõ chuoät vaøo tam giaùc beân phaûi ñeå choïn LOAD1. 

� Taïi muïc Load type and Direction (loaïi vaø höôùng taûi troïng taùc duïng) nhaáp choïn 
Forces (löïc). 

� Taïi muïc Direction (höôùng truïc taùc duïng) nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn 
Global Z. 

� Trong muïc Trapezoidal Loads (taûi troïng hình thang) tröôùc tieân baïn nhaáp chuoät vaøo 
Absolute distance from End -I ñeå ñònh khoaûng caùch nhaäp vaøo laø tuyeät ñoái sau ñoù baïn 
nhaäp vaøo nhöõng giaù trò nhö sau :  

Distance 2 2 8 8 

Load -2 -2 -1 -1 

Giaûi thích veà caùch nhaäp giaù trò : 

Distance laø khoaûng caùch töø nuùt ñaàu cuûa phaàn töû ñeán vò trí ñaët löïc taäp trung. 

Load laø giaù trò cuûa taûi troïng taäp trung ôû vò trí töông öùng . 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Trapezoidal Span Loads. 
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� Nhaáp chuoät vaøo phaàn töû thöù hai (tính töø traùi sang phaûi) nhö hình con troû chæ beân döôùi 

 

Töông töï nhö treân, baïn vaøo trình ñôn Assign > Frame Static Loads > Trapezoidal ñeå 
môû hoäp thoaïi Trapezoidal Span Loads. 

 

Hoäp thoaïi Trapezoidal Span Loads xuaát hieän : 

 

 Trong hoäp thoaïi Trapezoidal Span Loads baïn nhaäp vaøo nhöõng giaù trò nhö sau : 

Distance 0 2 8 10 

Load 0 -1 -2 0 

9 Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Trapezoidal Span Loads. 
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Hình khi gaùn taûi troïng vaøo phaàn töû thöù 2 

� Nhaáp chuoät vaøo phaàn töû thöù ba (tính töø traùi sang phaûi). 

 

 Hình khi nhaáp chuoät vaøo phaàn töû thöù 3 

Baây giôø baïn vaøo trình ñôn Assign > Frame Static Loads > Point and Uniform ñeå môû 
hoäp thoaïi Point and Uniform Span Loads. 

 

 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH  SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

 

 Trong hoäp thoaïi Point and Uniform Span Loads baïn khai baùo nhö sau : 

� Taïi muïc Load Case Name nhaáp vaø giöõ chuoät vaøo tam giaùc beân phaûi ñeå choïn 
LOAD1. 

� Nhaáp chuoät vaøo Absolute Distance from End-I 

� Taïi muïc Load type and Direction nhaáp choïn Forces. 

� Taïi muïc Direction nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn Global Z. 

� Taïi Point Loads taïi Distance nhaäp giaù trò laø 5 (vaøo hoäp soá1), Load : –30. 

� Nhöõng giaù trò khaùc khoâng khai baùo.  

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi 

 

10. GIAÛI BAØI TOAÙN 

           Khai baùo baät töï do vaø xuaát keát quûa baèng 
caùch vaøo trình ñôn Analyza > Set Options.(Ñeå 
hieåu baät töï do baïn haõy xem baøi toaùn khung 
phaúng).  
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Hoäp thoaïi Analysis Options xuaát hieän : 

 

Trong hoäp thoaïi Analysis Options 
baïn thöïc hieän theo trình töï sau : 

� Taïi muïc Available DOFs (caùc 
thoâng soá veà baät töï do theo caùc 
phöông) baïn duøng chuoät nhaáp 
choïn vaøo UZ vaø RY (nhö 
trong hoäp thoaïi treân) 

             

 

 

Nhaáp chuoät vaøo Generate Output sau ñoù nhaáp choïn Select Output Options ñeå môû hoäp 
thoaïi Select Output Results. 

Hoäp thoaïi Select Output Results xuaát hieän.  

 

Trong hoäp thoaïi Select Output Results duøng chuoät nhaáp choïn vaøo Displacements ñeå 
ñöa thoâng soá chuyeån vò taïi nuùt ra file keát quaû, sau ñoù nhaáp choïn vaøo Select/ Show Loads ñeå môû 
hoäp thoaïi Select Output. 
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Hoäp thoaïi Select Output xuaát hieän : 

 

 Trong hoäp thoaïi Select Output baïn nhaáp choïn vaøo LOAD1 Load Case vaø nhaáp OK ñeå 
ñoùng hoäp thoaïi. 

� Nhaáp chuoät vaøo Reaction/ Spring Forces vaø thöïc hieän nhö treân ñeå ñöa thoâng soá veà 
phaûn löïc hoaëc noäi löïc trong goái ñaøn hoài 

� Töông töï nhaáp choïn vaøo Frame Forces ñeå ñöa ra noäi löïc cuûa phaàn töû Frame 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output Results. 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Analysis Options. 

Tieáp theo baïn vaøo trình ñôn Analyze > 
Run hay duøng phím F5 treân baøn phím ñeå giaûi 
baøi toaùn. 

 
 

Khi ñoù baïn thaáy xuaát hieän hoäp thoaïi Save Model File As . 

 

Trong hoäp thoaïi Save Model File As trong muïc Save in baïn chæ ñöôøng daãn ñeå löu file, 
trong muïc File name baïn ñaët teân cho file laø “dam lien tuc”vaø nhaáp choïn Save ñeå file ñöôïc löu. 

Khi maùy giaûi xong neáu coù loãi seõ thaáy xuaát hieän doøng chöõ ERROR. Baïn duøng thanh tröôït 
ñöùng beân phaûi ñeå xem coù loãi hay khoâng. Neáu coù, baïn phaûi kieåm tra laïi döõ lieäu vaø thöïc hieän laïi 
böôùc giaûi. 

 Neáu quaù trình giaûi khoâng coù loãi baïn seõ nhaän ñöôïc moät baûng thoâng baùo coù haøng chöõ 
ANALYSIS COMPLETE khi ñoù baïn nhaáp choïn vaøo OK ñeå xem tröïc tieáp veà chuyeån vò. 
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Keát quaû chuyeån vò cuûa daàm 

11. XEM KEÁT QUAÛ 

Bieåu ñoà löïc caét 

Ñeå xem bieåu ñoà noäi löïc, ñaàu tieân baïn vaøo trình ñôn Display > Show Element Forces/ 
Stresses > Frames. 
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� Hoäp thoaïi Member Force Diagram 
for Frames xuaát hieän. 

� Trong hoäp thoaïi Member Force 
Diagram for Frames baïn duøng chuoät 
nhaáp vaøo Shear2-2 ñeå xem löïc caét theo 
phöông cuûa truïc X. 

Chuù yù : Neáu muoán xem bieåu ñoà löïc caét 
baïn duøng chuoät nhaáp choïn vaøo Fill 
Diagram. 

             Neáu muoán xem giaù trò veà bieåu ñoà 
löïc caét baïn nhaáp choïn vaøo Show Values on 
Diagram. 

 

 

  

 

Bieåu ñoà löïc caét 

 
Giaù trò bieåu ñoà löïc caét 
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Bieåu ñoà Momen 

            Töông töï nhö vaäy, baïn thöïc hieän laïi 
böôùc treân khi hoäp thoaïi Member Force 
Diagram for Frames xuaát hieän, baïn duøng 
chuoät nhaáp choïn vaøo Momen 3-3 ñeå xem 
momen xoaén quanh truïc ñòa phöông 3 vaø nhaáp 
choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

 

 

Bieåu ñoà Momen 

 
Giaù trò cuûa bieåu ñoà Momen 
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12. IN KEÁT QUAÛ 

Sau khi thöïc hieän xong, muoán in keát quaû ra giaáy baïn vaøo trình ñôn File > Print Output 
Tables hay baïn nhaán toå hoäp phím Ctrl + B, vôùi caùch in naøy thì keát quaû cuûa baïn ñöôïc in ra döôùi 
daïng vaên baûn. 

 

 Hoäp thoaïi Print Output Tables xuaát hieän : 

  

 Trong hoäp thoaïi Print Output Tables taïi muïc Type of Analysis Results baïn nhaáp choïn 
vaøo caùc thoâng tin maø baïn muoán in ra, sau ñoù nhaáp choïn Print to File vaø nhaáp choïn OK ñeå ñoùng 
hoäp thoaïi. 

Chuù yù : Taïi muïc File Name seõ xuaát hieän ñöôøng daãn maø baïn löu file ñoù laø C:\My 
Documents\ dam lien tuc. txt 
 Ví duï : Baïn nhaáp chuoät vaøo Displacements ñeå in ra keát quaû chuyeån vò. 
  Nhaáp chuoät vaøo Reactions ñeå in ra keát quaû veà phaûn löïc 
  Nhaáp choïn vaøo Frame Forces in ra noäi löïc veà phaàn töû cuûa thanh. 
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Tieáp theo baïn vaøo Start > Programs > Accessories > Wordpad. 

 

Chöông trình Wordpad xuaát hieän. 

 

Baây giôø baïn duøng chuoät nhaáp choïn vaøo Open nhö hình con troû chæ beân treân. 
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Hoäp thoaïi Open xuaát hieän : 

 

Trong hoäp thoaïi Open taïi muïc Look in baïn duøng chuoät nhaáp choïn vaøo tam giaùc beân phaûi 
ñeå choïn ñöôøng daãn C:\My Documents. 

Taïi muïc Files of type baïn duøng chuoät nhaáp choïn vaøo tam giaùc beân phaûi ñeå choïn ñònh 
daïng cuûa file laø Text Documents(*.txt). Tieáp theo, baïn nhaáp chuoät vaøo file coù teân “dam lien 
tuc” sau ñoù nhaáp choïn vaøo Open ñeå xuaát hieän keát quaû nhö hình beân döôùi. 

 

Chuùc möøng baïn thöïc hieän xong baøi taäp naøy. 
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BAØI TAÄP 2 

 HEÄ DAÀM GHEÙP  
 Trong baøi taäp naøy, baïn seõ thöïc taäp giaûi baøi toaùn heä daàm gheùp vaø daàm ñôn giaûn sau ñoù 
baèng keát quaû thöïc teá seõ ñöa ra keát luaän, neân söû duïng loaïi naøo thì kinh teá nhaát. Baèng chöông 
trình Sap 2000 baïn coù theå ñöa ra moät thoâng soá chính xaùc, sau ñoù so saùnh moät caùch nhanh choùng 
vaø deå daøng ñeå ñöa ra phöông phaùp toái öu. Thaät vaäy, ñeå thaáy ñöôïc ñieàu ñoù nhö theá naøo baïn haõy 
tieán haønh giaûi hai baøi toaùn nhö hình minh hoïa beân döôùi :      

 
Heä daàm gheùp 

 
Heä daàm ñôn giaûn 

1. KHÔÛI ÑOÄNG SAP 2000 

Vaøo trình ñôn Start choïn > Programs > SAP 2000NonLinear khi ñoù maøn hình xuaát hieän 
nhö hình beân döôùi : 
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2. ÑÔN VÒ TÍNH 

� Khai baùo ñôn vò tính laø KN-m baèng caùch, baïn duøng chuoät nhaáp choïn vaøo tam giaùc 
beân phaûi phía döôùi cuûa maøn hình vaø choïn KN-m. 

3. CHOÏN MAÃU KEÁT CAÁU 

� Tröôùc tieân baïn vaøo trình ñôn 
File > New Model hay nhaán toå 
hôïp phím Ctrl + N ñeå xuaát hieän 
hoäp thoaïi Coordinate System 
Definition. 

 

 

 Hoäp thoaïi Coordinate System Definition xuaát hieän : 

 

           Trong hoäp thoaïi Coordinate System 
Definition baïn thöïc hieän khai baùo theo trình töï 
sau : 

• Nhaáp chuoät vaøo Cartesian  

• Trong muïc Number of Grid 
Spaces baïn nhaäp vaøo giaù trò 
nhö sau : Taïi X direction laø 
17, Y direction : 8, Z 
direction : 1 vaø nhöõng muïc 
coøn laïi baïn nhaäp giaù trò laø 1 
sau cuøng nhaáp choïn OK ñeå 
ñoùng hoäp thoaïi. 
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� Khi nhaáp choïn OK, maøn hình xuaát hieän hai cöûa soå laøm vieäc nhö hình beân döôùi khi 
ñoù baïn nhaáp choïn vaøo Close ñeå ñoùng cöûa soå beân traùi. 

 

�  Vaøo trình ñôn View > Set 2D 
View hay nhaán toå hôïp phím 
Shift + Ctrl + F1 ñeå xuaát hieän 
hoäp thoaïi Set 2D View. 

� Hoäp thoaïi Set 2D View xuaát 
hieän : 
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 Trong hoäp thoaïi Set 2D view, taïi Plane baïn duøng chuoät nhaáp choïn vaøo X-Z plane sau ñoù 
nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

Luùc baáy giôø vuøng laøm vieäc xuaát hieän maûng löôùi nhö hình sau : 

 

4. Vaøo trình ñôn Draw > Draw Frame  
Element khi ñoù baïn thaáy bieåu töïông 

 xuaát hieän. 
 

 Tieáp theo baïn di chuyeån chuoät vaøo vuøng laøm vieäc sau ñoù nhaáp vaø giöõ chuoät taïi vò trí nhö 
hình beân döôùi. Baây giôø baïn nhaáp choïn vaøo vò trí oâ thöù 6 theo truïc X, khi thaû chuoät ra baïn thaáy 
treân ñöôøng löôùi xuaát hieän hai nuùt maøu vaøng. 

 
Vò trí nhaáp chuoät 

 
Hình khi thaû chuoät 
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 Töông töï nhö vaäy, vaãn giöõ chuoät baïn veõ tieáp baèng caùch nhaáp choïn vaøo oâ löôùi thöù 2 theo 
truïc X nhö hình beân döôùi :  Baïn tieáp tuïc thöïc hieän cho ñeán khi veõ xong caùc ñöôøng thaúng thì nhaán 
phím ESC treân baøn phím ñeå keát thuùc leänh veõ. 

 

 

 

 Ñeå nhìn thaáy roõ baïn nhaáp choïn vaøo F7 treân baøn phím, keát quaû seõ nhö hình beân döôùi. 

 
Hình khi thöïc hieän xong 

5. HIEÅN THÒ CAÙC THOÂNG SOÁ  

Ñeå hieån thò caùc thoâng soá cuûa phaàn töû 
leân maøn hình, ñaàu tieân baïn vaøo trình ñôn View 
> Set Elements hay nhaán toå hôïp phím Ctrl + 
E, ñeå xuaát hieän hoäp thoaïi Set Elements. 
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 Hoäp thoaïi Set Elements xuaát hieän : 

 
 Trong hoäp thoaïi Set Elements baïn khai baùo trình töï caùc thoâng soá nhö sau : 

• Trong hoäp thoaïi Joints nhaáp chuoät vaøo Labels ñeå ñaùnh daáu choïn chöùc 
naêng hieån thò soá hieäu cuûa nuùt vaø phaàn töû. 

• Trong hoäp thoaïi Frames nhaáp chuoät vaøo Labels. Sau cuøng baïn nhaáp choïn 
vaøo OK ñeå ñoùng hoäp thoaïi. 

 
Caùc thoâng soá ñaõ hieån thò treân daàm 

6. KHAI BAÙO ÑIEÀU KIEÄN BIEÂN 

� Ñeå khai baùo ñieàu kieän bieân baïn duøng chuoät nhaáp choïn nuùt thöù 1 vaø nuùt thöù 3 nhö 
hình sau : 
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� Tieáp theo, vaøo trình ñôn Assign 
> Joint > Restraints. 

� Hoäp thoaïi Joint Restraints xuaát 
hieän. 

 

� Trong hoäp thoaïi Joint 
Restraints taïi muïc Fast 
Restraints baïn duøng chuoät nhaáp 
choïn vaøo Tab thöù ba nhö hình 
con troû chæ beân treân, sau cuøng 
baïn nhaáp choïn vaøo OK ñeå ñoùng 
hoäp thoaïi. 

 

 

 Tieáp theo baïn nhaáp choïn vaøo nuùt soá 2 vaø soá 4 nhö hình sau : 
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� Vaøo trình ñôn Assign > Joint > Restraints. 

Hoäp thoaïi Joint Restraints xuaát hieän. 

 

 Trong hoäp thoaïi Joint Restraints taïi muïc 
Fast Restraints baïn duøng chuoät nhaáp choïn 
vaøo Tab thöù hai tính töø traùi sang phaûi, sau ñoù 
baïn nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

 
Lieân keát daõ xuaát hieän treân daàm 

7. KHAI BAÙO CAÙC ÑAËC TRÖNG VAÄT LIEÄU 

� Vaøo trình ñôn Define > 
Materials ñeå xuaát hieän hoäp 
thoaïi Define Materials. 

� Hoäp thoaïi Define Materials 
xuaát hieän. 

 

� Trong hoäp thoaïi Define 
Materials taïi muïc Materials 
baïn nhaáp chuoät vaøo CONC, 
trong muïc Click to nhaáp chuoät 
vaøo Modify / Show Material ñeå 
xuaát hieän hoäp thoaïi Material 
Property Data. 
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Trong hoäp thoaïi Material Property Data taïi muïc Analysis Property Data baïn tieán 
haønh khai baùo nhö sau : 

• Mass per unit Volume nhaäp vaøo giaù trò : 0  

• Weight per unit Volume baïn nhaäp vaøo giaù trò  : 2.5  

• Modulus of elasticity : 2.65e6  

• Poissons ratio : 0.2  

• Tieáp theo nhaáp choïn OK ñeå ñoùng hoäp thoaïi Material Property Data. 

• Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Materials. 

8. KHAI BAÙO ÑAËC TRÖNG HÌNH HOÏC VAØ GAÙN CHO PHAÀN TÖÛ DAÀM 

� Tröôùc tieân baïn vaøo trình 
ñôn Define > Frame 
Sections. 

� Hoäp thoaïi Define Frame 
Sections xuaát hieän. 

 

� Trong hoäp thoaïi Define 
Frame Sections taïi muïc 
Click to baïn duøng chuoät 
nhaáp choïn vaøo tam giaùc 
beân phaûi cuûa hoäp Add / 
Wide Flange ñeå choïn 
Add Rectangular nhö 
hình beân döôùi ñeå xuaát 
hieän hoäp thoaïi 
Rectangular Section. 
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 Hoäp thoaïi Rectangular Section xuaát hieän. 

 
 Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau: 

• Taïi muïc Section Name baïn nhaäp teân 0404. 

• Trong muïc Dimensions khai baùo tieát dieän cho coät baèng caùch nhaäp giaù trò 
vaøo muïc Depth laø 0.4, vaø muïc Width laø 0.4. 

• Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu 
laø CONC. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 

� Luùc baây giôø trong hoäp 
thoaïi Define Frame 
Sections ñaõ xuaát hieän teân 
daàm laø 0404 maø baïn ñaõ 
nhaäp vaøo. Nhaáp choïn OK 
ñeå ñoùng hoäp thoaïi Define 
Frame Sections. 

� Tieáp theo baïn duøng chuoät 
nhaáp choïn vaøo nhöõng 
phaàn töû thanh daàm nhö 
hình sau : 

 

 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 39 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

� Vaøo trình ñôn Assign > 
Frame > Sections. 

� Hoäp thoaïi Define Frame 
Sections xuaát hieän. 

 

 

� Trong hoäp thoaïi Define Frame Sections taïi muïc Name baïn duøng chuoät nhaáp vaøo 
chuoãi kyù töï 0404 sau ñoù nhaáp vaøo OK ñeå ñoùng hoäp thoaïi. 

 

]  

Hình khi thöïc hieän xong 
9. GAÙN TAÛI TROÏNG CHO DAÀM  

� Ñeå gaùn taûi troïng cho daàm, ñaàu 
tieân baïn vaøo trình ñôn Define > 
Static Load Cases. 
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Hoäp thoaïi Define Static Load Case Names xuaát hieän. 

 
 Trong hoäp thoaïi Define Static Load Case Names baïn thöïc hieän khai baùo nhö sau : 

• Nhaáp chuoät vaøo Change Load. 

 
• Taïi muïc Load baïn nhaäp vaøo chuoãi kyù töï TAP TRUNG, taïi muïc Self 

Weight Muliplier baïn nhaäp vaøo giaù trò laø 1, sau ñoù nhaáp chuoät vaøo Add 
new Load. 

• Thöïc hieän laàn thöù hai taïi muïc Load baïn nhaäp vaøo chuoãi kyù töï PHAN BO, 
sau ñoù nhaáp chuoät vaøo Add new Load. 

• Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Static Load Case Names. 

� Gaùn taûi troïng cho daàm : Ñeå gaùn taûi troïng cho daàm ñaàu tieân baïn duøng chuoät nhaáp 
choïn vaøo phaàn töû thöù nhaát (tính töø traùi sang phaûi). 
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� Vaøo trình ñôn Assign > Frame Static Loads > Point and Uniform. 

 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 
Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Load Case Name baïn duøng 

chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn TAPTRUNG. 
• Trong muïc Direction baïn choïn Global Z. 

• Nhaáp choïn vaøo Absolute Distance from End - I 

• Trong muïc Point Loads baïn khai baùo nhö sau : 
Distance 3 0 0 0 

Load -40 0 0 0 

• Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 
Taûi troïng ñaõ xuaát hieän treân phaàn töû 
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 Tieáp theo baïn duøng chuoät nhaáp choïn vaøo phaàn töû soá 3 nhö hình con troû chæ beân döôùi. 

 

� Tieáp theo, baïn gaùn löïc phaân boá leân phaàn töû baèng caùch vaøo trình ñôn Assign > 
Frame static Loads < Point and Uniform.  

 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 
 Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Load Case Name baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn PHANBO, taïi muïc Point Loads baïn nhaáp choïn 
vaøo Relative Distance from En-I, trong muïc Uniform Load nhaäp vaøo giaù trò laø –10, sau ñoù 
nhaáp choïn OK ñeå ñoùng hoäp thoaïi Point and Uniform Span Loads. 
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Taûi troïng phaân boá ñaõ xuaát hieän treân daàm 

10.KHAI BAÙO BAÄT TÖÏ DO 
Khai baùo baät töï do baèng caùch baïn vaøo trình ñôn Analyze > Set Options 

 
Hoäp thoaïi Analyze Options xuaát hieän : 

 

Trong hoäp thoaïi Analyze Options baïn thöïc hieän theo trình töï sau : 
• Taïi muïc Available SOFs (caùc thoâng soá veà baät töï do theo caùc phöông)baïn 

duøng chuoät nhaáp choïn vaøo UZ vaø RY(nhö trong hoäp thoaïi treân). 
• Nhaáp chuoät vaøo Generate Output sau ñoù nhaáp choïn Select Output 

Options ñeå xuaát hieän hoäp thoaïi Select Output Results. 
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Hoäp thoaïi Select Output Results xuaát hieän :  

 

• Trong hoäp thoaïi Select Output Results duøng chuoät nhaáp choïn vaøo 
Displacements ñeå ñöa thoâng soá chuyeån vò taïi nuùt ra file keát quaû, sau ñoù nhaáp 
choïn vaøo Select/ Show Loads ñeå xuaát hieän hoäp thoaïi Select Output. 

 

 Trong hoäp thoaïi Select Output baïn nhaáp choïn vaøo LOAD1 Load Case sau ñoù nhaán 
phím Ctrl vaø duøng chuoät nhaáp choïn PHANBO vaØ TAPTRUNG sau ñoù choïn OK ñeå ñoùng hoäp 
thoaïi. 

• Nhaäp chuoät vaøo Reaction/ Spring Forces vaø thöïc hieän laïi böôùc treân. 

• Töông töï nhaáp choïn vaøo Frame Forces ñeå ñöa ra noäi löïc cuûa phaàn töû Frame 

• Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output. 

• Nhaán choïn vaøo OK laàn hai ñeå ñoùng hoäp thoaïi Select Output Results. 

� Tieáp theo baïn vaøo trình ñôn Analyze < Run hay duøng phím F5 treân baøn phím ñeå 
giaûi baøi toaùn. 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 45 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

Hoäp thoaïi Save Model File As xuaát hieän : 

 
Trong hoäp thoaïi Save Model File As taïi muïc Save in baïn chæ ñöôøng daãn ñeå löu file, 

trong muïc File name baïn ñaët teân cho file laø “dam gheùp”vaø nhaáp choïn Save ñeå file ñöôïc löu. 

Khi maùy giaûi xong seõ xuaát hieän hoäp thoaïi coù doøng chöõ Analysis Complete luùc baáy giôø 
baïn nhaáp choïn OK ñeå xem chuyeån vò cuûa daàm. 

 

11. XEM KEÁT QUAÛ BIEÅU ÑOÀ  

Ñeå xem keát quaû baïn vaøo trình ñôn Display > Show Element Forces/ Stresses > Frames 
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 Hoäp thoaïi Member Force Diagram for Frames xuaát hieän : 

 

Trong hoäp thoaïi Member Force Diagram for 
Frames taïi muïc Load baïn nhaáp vaøo tam giaùc 
beân phaûi ñeå choïn PHAN BO sau ñoù baïn duøng 
chuoät nhaáp choïn vaøo Momen 3-3 ñeå xem 
momen xoaén quanh truïc ñòa phöông 3, nhaáp 
chuoät vaøo Show Values on Diagram vaø choïn 
vaøo OK ñeå ñoùng hoäp thoaïi. 

 
 Töông töï nhö vaäy baïn giaûi tieáp cho daàm ñôn giaûn baèng caùch baïn thöïc hieän laïi töøng böôùc 
soá 1 ñeán böôùc thöù 4 ñeå veõ daàm nhö beân döôùi. 

 
 Sau khi veõ daàm xong baïn thöïc hieän laïi böôùc thöù naêm nhö hình sau :  

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 47 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

 
12. KHAI BAÙO ÑIEÀU KIEÄN BIEÂN 

� Ñeå khai baùo ñieàu kieän bieân baïn duøng chuoät nhaáp choïn nuùt thöù 1 vaø thöù 4 nhö hình 
beân döôùi :  

 
Vò trí nhaáp chuoät 

� Vaøo trình ñôn Assign > Joint > Restraints. 

 
Hoäp thoaïi Joint Restraints xuaát hieän. 

 
 Trong hoäp thoaïi Joint Restraints taïi muïc Fast Restraints baïn duøng chuoät nhaáp choïn 
vaøo Tab thöù hai nhö hình con troû chæ beân treân, sau cuøng baïn nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 
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 Töông töï nhö vaäy baïn nhaáp choïn vaøo nuùt thöù 2 vaø 3. 

 
Baây giôø vaøo trình ñôn Assign > Joint > Restraints. 

Hoäp thoaïi Joint Restraints xuaát hieän : 

 
  Trong hoäp thoaïi Joint Restraints taïi muïc Fast Restraints baïn duøng chuoät nhaáp choïn vaøo 
tab thöù 3 nhö hình con troû chæ beân treân vaø nhaáp choïn OK. 
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 Baây giôø baïn thöïc hieän laïi töø böôùc 7 ñeán böôùc 9. 

 
13. KHAI BAÙO TAÛI TROÏNG CHO DAÀM 

• Tröôùc tieân baïn duøng chuoät nhaáp choïn vaøo phaàn töû ñaàu tieân nhö hình sau :  

 
•  Baây giôø baïn goïi leänh Assign > Frame Static Loads > Point and Uniform 

 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 
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Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Load Case Name baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn TAPTRUNG. 

• Trong muïc Direction baïn choïn Global Z. 

• Nhaáp choïn vaøo Absolute Distance from End - I 

• Trong muïc Point Loads baïn khai baùo nhö sau : 

Distance 3 0 0 0 

Load -40 0 0 0 

• Sau cuøng nhaáp choïn Ok ñeå ñoùng hoäp thoaïi. 

 
 Töông töï nhö vaäy baïn nhaáp choïn vaøo phaàn töû thöù hai sau ñoù thöïc hieän laïi böôùc khai baùo 
taûi troïng phaân boá nhö trong böôùc 9. 

 
Nhaáp chuoät vaøo phaàn töû soá 2 

 
 Taûi troïng phaân boá xuaát hieän treân phaàn töû soá hai 
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 Baây giôø baïn thöïc hieän laïi töø böôùc 10 vaø 11 cho ñeán khi hoäp thoaïi Save Model File As 
xuaát hieän. 

 Hoäp thoaïi Save Model File As xuaát hieän : 

 

Trong hoäp thoaïi Save Model 
File As taïi muïc Save in baïn 
chæ ñöôøng daãn ñeå löu file, 
trong muïc File name baïn 
ñaët teân cho file laø “dam don 
gian”vaø nhaáp choïn Save ñeå 
löu vaø ñoùng hoäp thoaïi. 

  Maùy tieán haønh giaûi baøi toaùn, khi hoäp thoaïi Analysis Complete xuaát hieän baïn nhaáp choïn 
vaøo OK ñeå xem chuyeån vò cuûa daàm. 
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14. XEM BIEÅU ÑOÀ NOÄI LÖÏC 

Tieáp theo baïn vaøo trình ñôn Display > Show Element Forces/ Stresses > Frames 

 Hoäp thoaïi Member Force Diagram for Frames xuaát hieän : 

 
 Trong hoäp thoaïi Member Force Diagram for Frames taïi muïc Load baïn nhaáp choïn 
TAPTRUNG vaø nhaáp chuoät vaøo Moment 3-3 sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 
 Baïn thöïc hieän laïi böôùc 11 ñeå xem bieåu ñoà momen.  
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15. SO SAÙNH  

 
Bieåu ñoà moment cuûa daàm gheùp 

 
Bieåu ñoà moment cuûa daàm ñôn giaûn 

 Baïn thaáy hai daàm coù cuøng nhòp vaø chòu taûi troïng töông ñöông nhöng moâmen lôùn nhaát 
trong daàm gheùp laø 50.91 kNm trong khi ñoù momen lôùn nhaát cuûa daàm ñôn giaûn laø 80kNm, ñieàu 
ñoù cho ta thaáy duøng daàm gheùp coù khaû naêng tieát kieäm vaät lieäu hôn so vôùi duøng daàm ñôn giaûn coù 
ñieàu kieän laøm vieäc töông ñöông. 

 Chuùc möøng baïn ñaõ hoaøn taát baøi taäp. 
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BAØI TAÄP 3 

BAØI TOAÙN HEÄ KHUNG  
Trong baøi naøy, baïn seõ thöïc haønh giaûi moät heä khung coù kích thöôùc nhö sau: 

 

� Chieàu daøi khung laø 5m vaø chieàu cao laø 3m 

� Khung chòu taûi troïng phaân boá ñeàu vôùi q = 1.15T/m 

� Vaät lieäu laø beâ toâng coát theùp(BTCT) vôùi moâ ñun ñaøn hoài : E = 2.65106 T/m2. 

� Heä soá Poisson v = 0.18 

� Troïng löôïng rieâng cuûa BTCT laø : 2.5 T/m3 

� Kích thöôùc cuûa coät 0.25 x 0.3. 

� Kích thöôùc cuûa daàm 0.2 x 0.4. 

Ñeå giaûi ñöôïc baøi toaùn baïn haõy tieán haønh trình töï qua caùc böôùc sau: 

1. KHÔÛI ÑOÄNG SAP 2000 

Töø trình ñôn Start choïn Windows > Programs > SAP 2000NonLinear. 

2. CHOÏN ÑÔN VÒ TÍNH TOAÙN 

      Nhaáp chuoät vaøo tam giaùc beân phaûi trong 
phaàn cuoái maøn hình ñeå choïn ñôn vò laø Ton-m. 
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3. TAÏO MOÄT MOÂ HÌNH MAÃU 

     Ñeå taïo moâ hình maãu ñaàu tieân baïn vaøo trình 
ñôn File > New Modol from Template. 

 
Hoäp thoaïi Model Template xuaát hieän : 

 
Trong hoäp thoaïi Model Template baïn duøng chuoät nhaáp choïn vaøo maãu thöù hai nhö hình 

con troû chæ beân treân ñeå xuaát hieän hoäp thoaïi Portal Frame. 

 Hoäp thoaïi Portal Frame xuaát hieän : 

 
 Trong hoäp thoaïi Portal Frame, baïn tieán haønh khai baùo caùc thoâng soá nhö sau : 

� Ñaàu tieân nhaáp chuoät vaøo Restraints ñeå boû choïn. 

� Nhaáp choïn vaøo Gridlines ñeå boû ñöôøng löôùi. 

� Taïi Number of Stories (soá taàng) nhaäp giaù trò : 1 

� Taïi Number of Bays (soá nhòp) nhaäp giaù trò : 1 

� Trong muïc Story Heigth (chieàu cao taàng) baïn nhaäp giaù trò : 3 

� Trong hoäp Bay Width (beà roäng cuûa nhòp) nhaäp giaù trò : 5. 

� Sau cuøng baïn nhaáp Ok ñeå ñoùng hoäp thoaïi Portal Frame. 

Maøn hình xuaát hieän hai cöûa soå laøm vieäc, khi ñoù baïn duøng chuoät nhaáp choïn vaøo Close(x) 
cuûa 3D view ñeå ñoùng cöûasoå khoâng gian baèng hình chieáu phoái caûnh, luùc naøy coøn laïi moät cöûa soå 
ñoù laø X-Y Plane @ Y= 0 baïn seõ tieán haønh laøm vieäc treân maët phaúng OXZ naøy. 
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Heä khung ñöôïc hình thaønh 

4. HIEÅN THÒ CAÙC THOÂNG SOÁ 

Ñeå hieån thò caùc thoâng soá treân khung ñaàu tieân baïn vaøo trình ñôn View > Set Elements 
hay baïn nhaán toå hôïp phím Ctrl + E 

 

Hoäp thoaïi Set Elements xuaát hieän : 

 

 Trong hoäp thoaïi Set Elements taïi muïc Joints baïn duøng chuoät nhaáp choïn vaøo Labels, taïi 
muïc Frames nhaáp choïn vaøo Labels vaø nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 
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Caùc thoâng soá xuaát hieän treân khung 

5. HIEÄU CHÆNH MOÂ HÌNH 

Nhaáp chuoät vaøo phaàn töû thöù nhaát (nhö hình con troû chæ beân döôùi) sau ñoù baïn nhaán phím 
Delete treân baøn phím ñeå xoaù phaàn töû naøy. 

 

Vò trí nhaáp chuoät 

 

Khung khi nhaán Delete 
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 Loaïi boû taát caû nhöõng thaønh phaàn dö treân 
vuøng laøm vieäc baèng caùch, baïn duøng chuoät nhaáp 
choïn vaøo Refresh Window . 

 
 

 

Hình khi thöïc hieän 

6. HIEÄU CHÆNH SOÁ THÖÙ TÖÏ 

            Ñeå thay ñoåi soá thöù töï cho nuùt, ñaàu tieân 
baïn nhaáp chuoät vaøo bieåu töôïng all treân thanh 
coâng cuï nhö hình sau:  

 
Taát caû ñoái töôïng ñaõ ñöôïc choïn 

 Baây giôø baïn vaøo trình ñôn Edit > Change Labels ñeå xuaát hieän hoäp thoaïi Relabel 
Selected Items 
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Hoäp thoaïi Relabel Selected Items xuaát hieän : 

 

Trong hoäp thoaïi Relabel Selected Items baïn tieán haønh khai baùo nhö sau: 

� Trong muïc Select Element (s) (choïn ñoái töôïng) baïn duøng chuoät nhaáp vaøo Frames 
ñeå boû choïn. 

� Trong muïc Change Label Initialization, taïi muïc Next Number (soá keá tieáp) baïn 
nhaäp giaù trò laø 1 vaø Increment (böôùc nhaûy) laø 1. 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 

Hình khi thöïc hieän xong 

7. KHAI BAÙO CAÙC ÑAËC TRÖNG VAÄT LIEÄU 

            Ñeå khai baùo ñaëc tröng vaät lieäu baïn 
thöïc hieän nhö sau :  Ñaàu tieân duøng chuoät 
nhaáp choïn vaøo coâng cuï Zoom out One 
Step ñeå thu nhoû vuøng laøm vieäc vöøa vôùi 
cheá ñoä laøm vieäc theo yù  baïn. 
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       Tieáp theo baïn vaøo trình ñôn Define > 
Materials ñeå xuaát hieän hoäp thoaïi Define 
Materials 

 
Hoäp thoaïi Define Materials xuaát hieän : 

 

 Trong hoäp thoaïi Define Materials taïi 
muïc Materials baïn nhaáp chuoät vaøo CONC, 
trong muïc Click to nhaáp chuoät vaøo Modify / 
Show Material ñeå xuaát hieän hoäp thoaïi 
Material Property Data. 
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Trong hoäp thoaïi Material Property Data taïi muïc Analysis Property Data baïn tieán 
haønh khai baùo nhö sau : 

� Mass per unit Volume nhaäp vaøo giaù trò :  0 (khoái löôïng rieâng)                                                       

� Weight per unit Volume baïn nhaäp giaù vaøo 2.5 (troïng löôïng rieâng cuûa beâ toâng coát 
theùp) 

� Modulus of elasticity : 2.56e6 (heä soá moâ ñun ñaøn hoài)  

� Poissons ratil : 0.18 (heä soá poisson). 

� Coeff of thermal expansion (heä soá daõn nôû vì nhieät) : 0. 

� Tieáp theo nhaáp choïn OK ñeå ñoùng hoäp thoaïi Material Property Data. 

 

� Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Materials. 

8. KHAI BAÙO ÑAËC TRÖNG HÌNH HOÏC 

      Ñaàu tieân baïn vaøo trình ñôn Define > 
Frame Sections. 

 
Hoäp thoaïi Define Frame Sections xuaát hieän. 

 

        Trong hoäp thoaïi Define Frame 
Sections taïi muïc Click to baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi 
cuûa hoäp Add / Wide Flange sau ñoù 
tröôït thanh tröôït ñöùng ñeå choïn Add 
Rectangular nhö hình beân döôùi. 
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 Hoäp thoaïi Rectangular Section xuaát hieän : 

 

Trong hoäp thoaïi Rectangular Section baïn khai baùo cho coät nhö sau : 

� Trong muïc Section Name baïn nhaäp vaøo doøng chöõ COT. 

� Taïi muïc Material khai baùo vaät lieäu cuûa coät vaø CONC. 

� Trong muïc Dimensions taïi Depth nhaäp giaù trò laø 0.25 vaø Width laø 0.3 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section 

Khi ñoùng hoäp thoaïi Rectangular Section baïn thaáy trong hoäp thoaïi Define Frame 
Sections taïi muïc Name xuaát hieän teân COT vöøa nhaäp. 

Baây giôø ñeå khai baùo cho daàm baïn duøng chuoät nhaáp choïn vaøo tam giaùc beân phaûi cuûa Add 
Rectangular ñeå choïn Add Rectangular. 
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Hoäp thoaïi Rectangular Section xuaát hieän : 

 

    Trong hoäp thoaïi 
Rectangular Section baïn thöïc hieän 
nhö phaàn khai baùo cho coät nhöng 
trong muïc Dimensions taïi Depth 
baïn nhaäp vaøo giaù trò laø 0.2 vaø 
Width laø 0.4 sau ñoù nhaáp OK ñeå 
ñoùng hoäp thoaïi Rectangular 
Section. 

 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Define Frame Sections. 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 64 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

9. KHAI BAÙO ÑAËC TRÖNG CHO PHAÀN TÖÛ 

Ñeå tieán haønh khai baùo ñaëc tröng cho phaàn töû khung baïn tieán haønh thöïc hieän nhö sau: 

Tröôùc tieân duøng chuoät nhaáp choïn vaøo thanh daàm (coù kyù hieäu laø soá 3) nhö hình con troû chæ 
beân döôùi. 

 
Vò trí nhaáp chuoät 

 Baây giôø baïn vaøo trình ñôn Assign > Frame > Sections ñeå xuaát hieän hoäp thoaïi Define 
Frame Sections 

 
 Hoäp thoaïi Define Frame Sections xuaát hieän : 

 
 Trong hoäp thoaïi Define Frame Sections taïi muïc Frame Sections trong muïc Name baïn 
duøng chuoät nhaáp choïn vaøo DAM sau ñoù choïn OK, khi ñoù treân phaàn töû soá 3 ñaõ xuaát hieän teân 
DAM nhö hình beân döôùi. 
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 Töông töï nhö vaäy baïn duøng chuoät nhaáp choïn vaøo thanh soá hai nhö hình beân döôùi.  

 
Töông töï nhö treân vaøo trình ñôn Assign > Frame > Sections ñeå xuaát hieän hoäp thoaïi 

Define Frame Sections. 

 

      Trong hoäp thoaïi Define 
Frame Sections taïi muïc Frame 
Sections trong muïc Name baïn 
duøng chuoät nhaáp choïn vaøo COT 
sau ñoù choïn OK. 
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Hình khi thöïc hieän 

10.GAÙN TAÛI TROÏNG CHO DAÀM VAØO COÄT 

Khai baùo taát caû tröôøng hoäp taûi :  

       Ñeå khai baùo taát caû tröôøng hoäp taûi, ñaàu tieân 
baïn vaøo trình ñôn Define > Static Load 
Cases. 

 
Hoäp thoaïi Define Static Load Case Names xuaát hieän :                                                                    

 
Trong hoäp thoaïi Define Static Load Case Names baïn tieán haønh theo trình töï sau: 

� Trong muïc Load (teân caùc tröôøng hôïp taûi troïng) baïn nhaäp vaøo chuoãi kyù töï TLBT,  

� Taïi muïc Type nhaáp vaøo tam giaùc beân phaûi ñeå choïn DEAD (taûi troïng tónh), 

� Trong muïc Self Weight Multiplier (heä soá coù keå ñeán taûi troïng baûn thaân keát caáu) 
baïn nhaäp vaøo giaù trò laø 1. 

� Nhaáp choïn vaøo Change Load ñeå chaáp nhaän söï thay ñoåi teân cuûa taûi. 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 67 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

 

Taûi ñaõ ñöôïc nhaäp vaøo 

Ñeå khai baùo tieáp nhöõng loaïi taûi khaùc baïn nhaáp choïn vaøo TLBT ñeåø ñoåi thaønh doøng chöõ 
PHAN BO, vaø trong muïc Type choïn LIVE (taûi troïng ñoäng), trong Self Weight Multiplier nhaäp 
vaøo giaù trò laø 0.0, sau ñoù baïn nhaáp choïn vaøo Add new Load nhö hoäp thoaïi beân döôùi. 

 

Hình khi nhaäp vaøo PHAN BO 

 

Hình khi nhaáp choïn vaøo Add new Load 
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 Töông töï nhö vaäy, baïn nhaäp vaøo taûi TAPTRUNG nhö hình beân döôùi vaø nhaáp OK ñeå 
ñoùng hoäp thoaïi. 

 
Hình khi nhaäp vaøo TAPTRUNG 

 
Hình khi thöïc hieän xong 

11.GAÙN TAÛI TROÏNG LEÂN DAÀM 

� Ñeå gaùn taûi troïng leân daàm vaø coät, tröôùc tieân baïn duøng chuoät nhaáp choïn vaøo phaàn töû 
thöù 3 nhö hình con troû beân döôùi. 
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       Tieáp theo baïn vaøo trình ñôn 
Assign > Frame static Loads < Point and 
Uniform. 

 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 
 Trong hoäp thoaïi Point and Uniform Span Loads  töø muïc Load Case Name baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn PHANBO, trong muïc Uniform Load nhaäp vaøo giaù 
trò laø –1.15, sau ñoù nhaáp choïn OK ñeå ñoùng hoäp thoaïi Point and Uniform Span Loads. 

 
Taûi troïng phaân boá ñaõ xuaát hieän treân daàm 
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� Tieáp theo baïn nhaáp choïn vaøo phaàn töû thöù hai nhö hình beân döôùi ñeå gaùn taûi troïng leân 
phaàn töû naøy. 

 

Vò trí nhaáp chuoät 

Baây giôø baïn goïi leänh Assign > Frame static Loads < Point and Uniform. 

Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Load Case Name baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn TAPTRUNG. 

� Trong muïc Direction baïn choïn GlobalX. Nhaáp choïn vaøo Absolute Distance from 
End – I. Trong muïc Point Loads taïi Distance cuûa hoäp soá 1 baïn nhaäp giaù trò laø1.5 vaø 
Load laø –2.5. Taïi muïc Uniform Load nhaäp giaù trò laø 0.0. Sau cuøng nhaáp choïn OK ñeå 
ñoùng hoäp thoaïi. 

 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 71 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

 

 Hình khi thöïc hieän xong 

� Khai baùo moâ men taäp trung baèng caùch duøng chuoät nhaáp choïn vaøo nuùt soá 1 nhö hình 
beân döôùi. 

 

Vò trí nhaáp chuoät 

� Tieáp theo baïn vaøo trình ñôn Assign 
> Joint Static Loads > Forces. 

 
Hoäp thoaïi Joint Forces xuaát hieän : 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 72 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

� Trong hoäp thoaïi Joint 
Forces taïi muïc Load 
Case Name baïn nhaáp 
chuoät vaøo tam giaùc beân 
phaûi ñeå choïn 
TAPTRUNG, 

�  Trong muïc Loads taïi 
Monent Global YY 
nhaäp vaøo giaù trò : –1.5 
vaø nhaáp choïn OK ñeå 
ñoùng hoäp thoaïi Joint 
Forces. 

 

 
12.TOÅ HÔÏP TAÛI  

Ñeå toå hôïp taûi baïn vaøo trình ñôn Define > Load combinations. 

 

     Hoäp thoaïi Define Load Combinations xuaát hieän. 
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 Trong hoäp thoaïi Define Load Combinations baïn duøng chuoät nhaáp choïn vaøo Add New 
Combo ñeå xuaát hieän hoäp thoaïi Load Combinations Data. 

 Hoäp thoaïi Load Combinations Data xuaát hieän 

 

    Trong hoäp thoaïi Load Combinations 
Data baïn tieán haønh khai baùo theo trình töï 
sau : 

� Trong muïc Load Combinations 
Name nhaäp vaøo COMB1. 

� Trong muïc Load Combinations 
Type nhaáp choïn ADD. 

� Trong muïc Title nhaäp vaøo kyù töï 
sau TT+1.2 TPB 

� Trong muïc Define Combination 
baïn nhaáp vaøo tam giaùc beân phaûi 
ñeå choïn PHANBO. 

� Trong hoäp Scale Factor nhaäp vaøo 
giaù trò laø 1.2. 

 

� Sau cuøng baïn nhaáp choïn Add vaø choïn OK ñeå ñoùng hoäp thoaïi. 

Luùc baáy giôø trong hoäp thoaïi Define Load Combinations ñaõ xuaát hieän toå hôïp taûi thöù nhaát 
laø COMB1 nhö hình beân döôùi. 

 

� Tieáp theo baïn nhaáp chuoät 
vaøo Add New Combo nhö 
hình con troû chæ ñeå khai baùo 
toå hôïp taûi thöù hai. 

 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 74 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

Hoäp thoaïi Load Combinations Data xuaát hieän : 

 

           Töông töï nhö treân nhöng trong muïc 
Title nhaäp vaøo kyù töï sau TT+1.4 TTT, trong 
muïc Define Combination baïn nhaáp vaøo 
tam giaùc beân phaûi ñeå choïn TAPTRUNG, 
trong hoäp Scale Factor nhaäp vaøo giaù trò laø 
1.4 sau ñoù nhaáp chuoät vaøo Add vaø choïn OK. 

� Nhaáp chuoät vaøo Add New Combo ñeå 
khai baùo toå hôïp taûi thöù 3. 

� Hoäp thoaïi Load Combinations Data 
xuaát hieän : 

 

 

 Thöïc hieän laïi böôùc treân ñeå tieán haønh 
toå hôïp taûi thöù 3 (COMB3) nhö sau : taïi muïc 
Title nhaäp vaøo kyù töï TT+PB+TT vaø muïc 
Define Combination baïn nhaáp vaøo tam giaùc 
beân phaûi ñeå choïn PHANBO, trong muïc 
Scale Factor nhaäp vaøo giaù trò laø 1 nhaáp 
choïn Add. 

Chuù yù : Neáu khi khai baùo taûi taäp trung vaø 
phaân boá baïn thaáy baùo loãi khi ñoù baïn nhaáp 
choïn Ok vaø thöïc hieän tieáp. 

Baây giôø baïn nhaáp chuoät vaøo TAP 
TRUNG vaø choïn Add sau ñoù choïn OK ñeå 
keát thuùc vieäc toå hôïp taûi. 
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13.KHAI BAÙO ÑIEÀU KIEÂN BIEÂN 

Duøng chuoät nhaáp choïn vaøo nuùt thöù 2 nhö hình sau : 

  
� Tieáp theo baïn vaøo trình ñôn Assign 

> Joint > Restaints 

 
      Hoäp thoaïi Joint Restraints xuaát hieän : 

 

� Trong hoäp thoaïi Joint Restraints 
trong muïc Fast Restraints baïn 
duøng chuoät nhaáp choïn vaøo bieåu 
töôïng ngaøm thöù nhaát nhö hình con 
troû chæ beân caïnh vaø nhaáp choïn OK 
ñeå ñoùng hoäp thoaïi. 
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Khung ñaõ xuaát hieän bieåu töôïng ngaøm 

 Töông töï nhö vaäy baïn duøng chuoät nhaáp choïn vaøo nuùt thöù nhaát nhö hình sau : 

 
Hình khi nhaáp choïn vaøo nuùt 

� Baây giôø baïn vaøo trình ñôn Assign > 
Joint > Restaints, 

�  Khi hoäp thoaïi Joint Restaints xuaát 
hieän trong muïc Fast Restraints baïn 
nhaáp vaøo bieåu töôïng khôùp thöù hai 
nhö hình beân vaø nhaáp choïn OK ñeå 
ñoùng hoäp thoaïi Joint Restaints. 
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Hình khi thöïc hieän xong 

14.CHOÏN THOÂNG SOÁ CHO QUAÙ TRÌNH GIAÛI BAØI TOAÙN 

� Tröôùc tieân baïn vaøo trình ñôn 
Analyze > Set Options. 

 
 Hoäp thoaïi Analysis Options xuaát hieän : 

 
Trong hoäp thoaïi Analysis Options baïn thöïc hieän theo trình töï sau: 

� Taïi muïc Available DOFs baïn duøng chuoät nhaáp choïn vaøo UX,UZ, RY coøn caùc oâ khaùc 
ñeå troáng (nhö trong hoäp thoaïi treân). 

� Nhaáp chuoät vaøo Generate Output sau ñoù nhaáp choïn Select Output Options ñeå hieån 
thò hoäp thoaïi Select Output Results. 
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Hoäp thoaïi Select Output Results xuaát hieän :  

 
� Trong hoäp thoaïi Select Output Results duøng chuoät nhaáp choïn vaøo Displacements, 

sau ñoù nhaáp choïn vaøo Select/ Show Loads ñeå xuaát hieän hoäp thoaïi Select Output. 

� Trong hoäp thoaïi Select Output baïn nhaáp choïn vaøo loaïi taûi sau ñoù nhaán vaø giöõ phím 
Shift nhaáp choïn töøng loaïi taûi ñeå choïn taát caû tröôøng hôïp taûi vaø nhaáp OK ñeå ñoùng hoäp 
thoaïi. 

� Thöïc hieän töông töï nhö treân cho nhöõng phaàn beân döôùi. 

� Nhaáp chuoät vaøo Reaction/ Spring Forces 

� Töông töï nhaáp choïn vaøo Frame Forces ñeå ñöa ra noäi löïc cuûa phaàn töû Frame 

� Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output  

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output Results 

15. GIAÛI BAØI TOAÙN 

� Ñeå giaûi baøi toaùn, tröôùc tieân baïn choïn 
maët caét baèng caùch nhaáp choïn vaøo bieåu 
töôïng ALL treân thanh coâng cuï 
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� Baây giôø baïn vaøo trình ñôn Assign > Frame > Output Segments. 

 

Hoäp thoaïi Frame Output Segments xuaát hieän : 

 

� Trong hoäp thoaïi Frame 
Output Segments taïi 
muïc Number Of 
Segments baïn nhaäp vaøo 
giaù trò laø 2 sau ñoù nhaáp 
choïn OK ñeå ñoùng hoäp 
thoaïi Frame Output 
Segments. 

 

� Ñeå baøi toaùn ñöôïc chính 
xaùc baïn chia daàm ra 
thaønh nhieàu phaàn baèng 
caùch duøng chuoät nhaáp 
choïn vaøo daàm nhö hình 
beân. 

 Tieáp theo baïn goïi leänh Edit > Divide Frames. 
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 Hoäp thoaïi Divide Selected Frames xuaát hieän : 

 

� Trong hoäp thoaïi Divide Selected 
Frames taïi muïc Divide into baïn nhaäp 
vaøo giaù trò : 8 Frames, trong muïc Last / 
first radio laø1  

� Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp 
thoaïi. 

 

Hình khi thöïc hieän xong 

� Töông töï nhö vaäy baïn duøng chuoät nhaáp vaøo coät vaø khai baùo taïi taïi muïc Divide into baïn 
nhaäp vaøo giaù trò : 4 Frames, trong muïc Last / first radio laø1 sau cuøng nhaáp choïn vaøo OK 
ñeå ñoùng hoäp thoaïi. 

  

� Thöïc hieän giaûi baèng caùch vaøo trình ñôn 
Analyze > Run hay duøng phím F5 treân 
baøn phím.  
Hoäp thoaïi Save Model File As xuaát hieän : 
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Khi ñoù baïn thaáy xuaát hieän hoäp thoaïi Save Model File As, trong muïc Save in cuûa hoäp 
thoaïi Save Model File As baïn chæ ñöôøng daãn ñeå löu file, trong muïc File name baïn ñaët teân cho 
file vaø nhaáp choïn Save ñeå file ñöôïc löu. 

 
Baây giôø maùy tieán haønh giaûi, khi maùy giaûi xong seõ xuaát hieän hoäp thoaïi Analysis 

Complete neáu xuaát hieän doøng Error baïn phaûi tieán haønh khai baùo laïi.  

 
� Trong hoäp thoaïi Analysis Complete baïn 

nhaäp choïn OK ñeå xem keát quaû chuyeån 
vò nhö hình sau: 

 
 Hình chuyeån vò 
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16. XEM KEÁT QUAÛ 

Ñeå xem keát quaû baïn thöïc hieän nhö sau : Ñaàu tieân baïn vaøo trình ñôn Display > Show 
Element Forces / Stresses> Frames. 

 
 Hoäp thoaïi Member Force Diagram for Frames xuaát hieän : 

 

� Trong hoäp thoaïi Member Force 
Diagram for Frames taïi Load baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi 
ñeå choïn COMB3Combo 

� Taïi muïc Component nhaáp chuoät vaøo 
Axial Force ñeå xem löïc doïc nhö hình 
beân döôùi. 

� Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 
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� Caùch thöïc hieän töông töï nhö treân : Vaøo 
trình ñôn Display > Show Element 
Forces / Stresses> Frames. 

� Trong hoäp thoaïi Member Force 
Diagram for Frames taïi Load baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi 
ñeå choïn COMB3Combo 

� Tieáp theo duøng chuoät nhaáp vaøo Moment 
3-3 ñeå xem Moment xoaén quanh truïc ñòa 
phöông 3-3. 

 
Bieåu ñoà momen  

�  Thöïc hieän nhö böôùc treân. Sau ñoù ñeå 
xem löïc caét baïn duøng chuoät nhaáp choïn 
vaøo Shear 2-2 nhö hoäp thoaïi hình beân. 
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Bieåu ñoà löïc caét 

 Chuùc baïn thaønh coâng. 
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BAØI TAÄP 4  

HIEÄU CHÆNH KHUNG PHAÚNG  
Trong baøi taäp naøy, baïn seõ thöïc haønh caùch hieäu chænh khung phaúng, vì coù nhöõng daïng 

khung khoâng coù trong maãu Template do vaäy baïn phaûi bieát hieäu chænh vaø thay ñoåi sao cho khung 
phaúng trôû thaønh moät heä khung maø mình muoán.  

Khung phaúng coù daïng nhö hình beân döôùi. 

 
Soá lieäu ban ñaàu  

� Moät khung goàm 8 taàng, 6 nhòp, kích thöôùc cho treân hình. 

� Vaät lieäu laø beâ toâng coát theùp (BTCT) vôùi moâ ñun ñaøn hoài : E= 2.65106 T/m2. 

� Heä soá Poisson v = 0.2. 

� Troïng löôïng rieâng cuûa BTCT laø : 2.5 T/m3 

� Kích thöôùc cuûa coät 0.4 x 0.4. 

� Kích thöôùc cuûa daàm 0.3 x 0.4. 

� Taûi troïng phaân boá treân taàng 1, 2, 3, 4 laø 0.7 T/m 

� Taûi troïng phaân boá treân taàng 5, 6, 7,8 laø 0.6 T/m. 

Ñeå hieäu chænh ñöôïc khung nhieàu taàng nhö hình treân baïn haõy tieán haønh qua caùc böôùc sau 

1. KHÔÛI ÑOÄNG SAP 2000 

Vaøo trình ñôn Start choïn Programs > SAP 2000 Nonlinear > SAP 2000 Non Linear. 
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2. CHOÏN ÑÔN VÒ TÍNH  

Sau khi khôûi ñoäng Sap 2000, moät maøn hình xuaát hieän, khi ñoù baïn duøng chuoät nhaáp choïn 
vaøo tam giaùc beân phaûi (goùc phaûi cuûa maøn hình) ñeå choïn ñôn vò tính laø Ton –m. 

3. CHOÏN MAÃU KEÁT CAÁU 

Ñeå choïn maãu keát caáu baïn vaøo trình ñôn File > New Model from Template 

 

Hoäp thoaïi Model Templates xuaát hieän : 

 

Trong hoäp thoaïi Model Templates baïn duøng chuoät nhaáp choïn vaøo maãu thöù hai (tính töø 
traùi sang phaûi) ñeå xuaát hieän hoäp thoaïi Portal Frame. 

 

Trong hoäp thoaïi Portal Frame baïn duøng chuoät nhaáp choïn vaøo Rectraints ñeå boû caùc lieân 
keát maëc ñònh sau ñoù baïn nhaäp vaøo giaù trò nhö sau : 

• Taïi Number of Stories (soá taàng) nhaäp giaù trò : 8 

• Taïi Number of Bays (soá nhòp) nhaäp giaù trò : 6 

• Story Height (chieàu cao taàng) : 5 

• Trong hoäp Bay Width (beà roäng cuûa nhòp) nhaäp giaù trò : 6 

• Sau cuøng baïn nhaáp OK ñeå ñoùng hoäp thoaïi Portal Frame. 
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Tieáp theo baïn duøng chuoät nhaáp choïn vaøo Close cuûa cöûa soå 3D View ñeå ñoùng cöûa soå naøy.  

 
� Baây giôø baïn duøng chuoät nhaáp 

choïn vaøo coâng cuï Zoom Out One 
Step 3 laàn ñeå vuøng laøm vieäc vöøa 
vôùi taàm nhìn. 

 

 
Hình khi thöïc hieän xong 

� Tieáp theo baïn vaøo trình ñôn View 
> Show Grid hay nhaán phím F7 
treân baøn phím ñeå daáu ñöôøng löôùi. 
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Hình khi thöïc hieän xong 

4. XOAÙ BOÛ ÑOÁI TÖÔÏNG DÖ 

� Ñeå xoùa boû ñoái töôïng dö baïn thöïc hieän nhö sau : Ñaàu tieân baïn di chuyeån chuoät vaøo 
vò trí nhö hình beân döôùi. 

 
� Tieáp theo baïn nhaáp vaø giöõ chuoät keùo xieân qua phaûi ñeå taïo moät vuøng choïn hình chöõ 

nhaät bao phuû toaøn boä nhö hình beân döôùi sau ñoù thaû chuoät ra. 
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� Luùc baáy giôø khi thaû chuoät ra treân khung seõ xuaát hieän nhöõng daáu gaïch cheùo, baïn 
nhaán phím Delete treân baøn phím ñeå boû nhöõng vuøng dö naøy. 

 

Hình khi thaû chuoät 

 

Hình khi nhaán phím Delete 

� Töông töï nhö vaäy baïn taïo moät vuøng choïn thöù hai nhö hình beân döôùi vaø nhaán phím 
Delete. 

 

Taïo vuøng choïn 
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Hình khi nhaán phím Delete 

 Taïo vuøng choïn thöù ba vaø nhaán phím Delete. 

 

 

Hình khi nhaán phím Delete 

 Taïo vuøng choïn thö ùtö. 

 
Hình khi taïo vuøng choïn 
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Hình khi nhaán phím Delete 

� Töông töï nhö treân, taïo vuøng choïn keát quaû nhö hình beân döôùi sau ñoù baïn nhaán 
Delete treân baøn phím ñeå boû thanh. 

 

Taïo vuøng choïn keát tieáp 

 
Taïo vuøng choïn sau ñoù nhaán Delete 
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Taïo vuøng choïn sau cuøng vaø nhaán Delete 

� Tieáp theo ñeå laøm saïnh maøn hình 
baïn duøng chuoät nhaáp choïn vaøo 
coâng cuï Refresh Window  

 
Hình khi thöïc hieän xong 

5. ÑIEÀU CHÆNH KÍCH THÖÔÙC 

� Ñeå ñieàu chænh kích thöôùc ñaàu tieân baïn haõy baät löôùi baèng caùch nhaán phím F7 treân 
baøn phím. 

� Ñieàu chænh chieàu cao taàng : 

Baïn seõ ñieàu chænh chieàu cao töø 5 m xuoáng coøn 4 m baèng caùch nhaáp ñuùp chuoät vaøo 
ñöôøng löôùi treân cuøng beân traùi nhö hình sau ñeå xuaát hieän hoäp thoaïi Modify Grid Lines. 
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Vò trí nhaáp chuoät 

Hoäp thoaïi Modify Grid Lines xuaát hieän : 

             Trong hoäp thoaïi Modify Grid Lines 
baïn tieán haønh khai baùo nhö sau : 

• Ñaàu tieân baïn duøng chuoät 
nhaáp choïn vaøo Glue Joints 
to Grid Lines 

• Taïi muïc Direction baïn 
duøng chuoät nhaáp choïn vaøo 
nuùt Z 

• Trong muïc Z Location taïi 
giaù trò 40 baïn nhaäp vaøo 39. 

• Nhaáp chuoät vaøo Move Grid 
Line ñeå di chuyeån ñöôøng 
löôùi. 

 

� Sau cuøng nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

Khi nhaáp choïn vaøo OK baïn thaáy chieàu cao taàng ñaõ haï xuoáng 1 m nhö hình beân döôùi. 
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 Töông töï nhö treân baïn haõy thöïc hieän cho nhòp. 

� Nhòp daøi 6m thaønh 5m : 

Nhaáp ñuùp chuoät vaøo ñöôøng löôùi doïc, beân phaûi nhö hình con troû chæ beân döôùi. 

 

 Hoäp thoaïi Modify Grid Lines xuaát hieän 

 

 Trong hoäp thoaïi Modify Grid Lines taïi muïc X Location baïn nhaäp vaøo giaù trò 17 sau ñoù 
nhaáp choïn vaøo Move Grid Line vaø nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 
Hình khi thöïc hieän xong 

� Nhòp 6m thaønh 7 m, baïn thöïc hieän töông töï nhö treân ñeå xuaát hieän hoäp thoaïi Move 
Grid Line. Trong hoäp thoaïi Move Grid Line baïn nhaäp giaù trò nhö hình beân döôùi. 
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� Tieáp theo baïn nhaán phím F7 ñeå daáu ñi ñöôøng löôùi. 

 
Hình khi thöïc hieän hoaøn taát 

6. SOÁ THÖÙ TÖÏ 

� Soá thöù töï cuûa nuùt : Treân thanh coâng cuï baïn duøng chuoät nhaáp choïn vaøo Select All 
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 Khi nhaáp choïn vaøo Seclect All baïn thaáy treân khung xuaát hieän nhöõng daáu gaïch cheùo nhö 
hình beân treân, baây giôø baïn thöïc hieän tieáp baèng caùch vaøo trình ñôn Edit > Change Labels. 

 

Hoäp thoaïi Relabel Selected Items xuaát hieän] 

 

  Trong hoäp thoaïi Relabel Selected Items baïn thöïc hieän khai baùo nhö sau: 

• Taïi muïc Select Element baïn duøng chuoät nhaáp choïn vaøo Frames ñeå boû 
choïn. 

• Trong muïc Change Label Initialization taïi Next Number (Soá keá tieáp) 
nhaäp vaøo giaù trò laø 1 vaø taïi Increment (böôùc nhaûy) laø 1. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 97 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

� Baây giôø vaãn khoâng thaáy hieän soá treân khung, ñeå hieän soá baïn vaøo View> Set 
Elements hay nhaán toå hôïp phím Ctrl + E. 

 
 Hoäp thoaïi Set Elements xuaát hieän 

 
Trong hoäp thoaïi Set Elements taïi muïc Joints baïn nhaáp chuoät vaøo Labels, töông töï nhö 

vaäy taïi muïc Frames baïn nhaáp choïn vaøo Labels. 

� Khi nhaáp choïn OK caùc thoâng soá ñaõ 
hieån thò nhöng nhoû quaù, baïn haõy 
duøng coâng cuï Zoom In One Step 
vaøi laàn ñeå phoùng lôùn, khi quan saùt 
vöøa yù, sau ñoù baïn phaûi trôû veà vò trí 
ban ñaàu baèng caùch nhaáp choïn vaøo 
Zoom Out One Step. 

 
� Nhaáp choïn vaøo coâng cuï Pan 

(bieåu töôïng baøn tay) ñeå di 
chuyeån vuøng nhìn. 
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� Soá thöù töï cuûa coät : 

  Ñeå ñaùnh soá thöù töï cho coät tröôùc tieân baïn phaûi choïn coät, baèng caùch choïn trình töï caùc coät 
nhö hình sau : Nhaán vaø giöõ chuoät sau ñoù keùo xieân chuoät veà phía döôùi ñeå taïo moät hình chöõ nhaät 
bao phuû toaøn boä coät ñaàu tieân beân traùi vaø thaû chuoät ra. 

Khi baïn thaû chuoät ra baïn seõ thaáy nhöõng daáu gaïch cheùo xuaát hieän treân coät nhö hình sau : 
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 Baïn thöïc hieän töông töï cho ñeán coät cuoái cuøng beân phaûi. 

 
Taïo vuøng choïn cho coät sau cuøng  

 
Hình khi thöïc hieän xong 
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� Tieáp theo baïn vaøo trình ñôn Edit > Change Lables .  

� Hoäp thoaïi Relabel Selected Items xuaát hieän : 

 
Trong hoäp thoaïi Relabel Selected Items ñaàu tieân taïi muïc Select Element (s) baïn duøng 

chuoät nhaáp choïn vaøo Joints ñeå boû choïn, trong muïc Change Label Initialization taïi Next 
Number nhaäp vaøo giaù trò laø 1 , taïi Increment laø 1. Nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

� Soá thöù töï cuûa daàm: 

             Tröôùc tieân baïn choïn daàm baèng caùch 
treân thanh coâng cuï nhaáp choïn vaøo 
Intersecting Line.  

Di chuyeån chuoät vaøo vuøng laøm vieäc sau ñoù nhaáp vaø giöõ chuoät keùo moät ñöôøng thaúng 
ngang qua caùc daàm. 

 
Vò trí nhaáp chuoät 
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Baïn thöïc hieän töông töï cho ñeán daàm cuoái cuøng nhö hình sau : 

 
Daàm cuoái cuøng  
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� Vaøo trình ñôn Edit > Change Labels, ñeå xuaát hieän hoäp thoaïi Relabel Selected 
Items. 

 Trong hoäp thoaïi Relabel Selected Items baïn nhaáp choïn OK. 

 
7. ÑIEÀU KIEÄN BIEÂN 

� Ñeå khai baùo ñieàu kieän bieân baïn choïn 7 nuùt döôùi cuøng baèng caùch duøng chuoät nhaáp 
choïn töøng nuùt. 

 
� Baây giôø baïn vaøo trình ñôn 

Assign > Joint > Restraints. 

 
  

       Hoäp thoaïi Joint Restraints xuaát hieän : 

�  Trong hoäp thoaïi Joint 
Restraints baïn duøng chuoät nhaáp 
choïn vaøo bieåu töôïng ngaøm nhö 
hình con troû chæ beân caïnh, sau 
ñoù nhaáp choïn vaøo OK ñeå ñoùng 
hoäp thoaïi. 
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Luùc baáy giôø lieân keát ngaøm ñaõ xuaát hieän nhö hình beân döôùi. 

 
8. KHAI BAÙO CAÙC ÑAËC TRÖNG VAÄT LIEÄU 

� Vaøo trình ñôn Define > Materials ñeå xuaát hieän hoäp thoaïi Define Materials. 

 Hoäp thoaïi Define Materials xuaát hieän : 

 
 Trong hoäp thoaïi Define Materials taïi muïc Materials baïn nhaáp chuoät vaøo CONC, trong 
muïc Click to nhaáp chuoät vaøo Modify / Show Material ñeå xuaát hieän hoäp thoaïi Material 
Property Data. 
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Trong hoäp thoaïi Material Property Data taïi muïc Analysis Property Data baïn tieán 
haønh khai baùo nhö sau : 

• Mass per unit Volume nhaäp vaøo giaù trò :0  

• Weight per unit Volume baïn nhaäp vaøo giaù trò : 2.5  

• Modulus of elasticity : 2.65e6  

• Poissons ratio : 0.2  

• Tieáp theo nhaáp choïn OK ñeå ñoùng hoäp thoaïi Material Property Data. 

• Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Materials. 

9. KHAI BAÙO CAÙC ÑAËC TRÖNG VEÀ HÌNH HOÏC  

Khai baùo cho coät : 

� Ñaàu tieân baïn vaøo trình ñôn Define > Frame Sections. 

 Hoäp thoaïi Define Frame Sections xuaát hieän. 

 
 Trong hoäp thoaïi Define Frame Sections taïi muïc Click to baïn duøng chuoät nhaáp choïn vaøo 
tam giaùc beân phaûi cuûa hoäp Add / Wide Flange ñeå choïn Add Rectangular nhö hình beân döôùi ñeå 
xuaát hieän hoäp thoaïi Rectangular Section. 
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 Hoäp thoaïi Rectangular Section xuaát hieän : 

 

Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau : 

• Taïi muïc Section Name baïn nhaäp teân 0404. 

• Trong muïc Dimensions khai baùo tieát dieän cho coät baèng caùch nhaäp giaù trò 
vaøo muïc Depth laø 0.4, vaø muïc Width laø 0.4. 

• Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu 
laø CONC. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 

Khai baùo cho daàm : 

Khi nhaáp choïn OK trong hoäp thoaïi Define Frame Sections xuaát hieän teân coät (0404) maø 
baïn vöøa khai baùo, baây giôø baïn nhaáp choïn tieáp Add Rectangular ñeå xuaát hieän hoäp thoaïi 
Rectangular Section. 
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 Hoäp thoaïi Rectangular Section xuaát hieän : 

 

  Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau : 

• Taïi muïc Section Name baïn nhaäp teân 0304 

• Trong muïc Dimensions khai baùo tieát dieän cho coät baèng caùch nhaäp giaù trò 
vaøo muïc Depth laø 0.3, vaø muïc Width laø 0.4. 

• Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu 
laø CONC. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 

 

Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Define Frame Sections. 
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10. KHAI BAÙO ÑAËC TRÖNG CHO PHAÀN TÖÛ 

Khai baùo cho coät : 

 Ñeå khai baùo cho coät, ñaàu tieân baïn choïn taát caû coät, baèng caùch choïn töông töï nhö phaàn 
treân. 

 
Hình khi choïn coät 

 Vaøo trình ñôn Assign > Frame > 
Sections. 

 
 Hoäp thoaïi Define Frame Sections xuaát hieän : 

 
 Trong hoäp thoaïi Define Frame Sections baïn nhaáp chuoät vaøo 0404 vaø choïn OK. 
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Ñeå nhìn thaáy ñöôïc nhöõng gì treân phaàn töû, baïn neân phoùng lôùn khung, baèng caùch nhaáp 
choïn vaøo coâng cuï Zoom In One Step vaøi laàn ñeå phoùng lôùn vaø nhaáp vaøo Zoom Out In One Step 
keá beân ñeå thu nhoû. 

 

 

 Khai baùo cho daàm : 

 Ñeå khai baùo cho daàm, ñaàu tieân baïn choïn daàm, caùch choïn töông töï nhö phaàn tröôùc. Sau 
khi choïn daàm xong baïn vaøo trình ñôn Assign > Frame > Sections. 

 Hoäp thoaïi Define Frame Sections xuaát hieän : 

 

 Trong hoäp thoaïi Define Frame Sections taïi muïc Name baïn nhaáp choïn vaøo 0304 vaø 
nhaáp choïn OK ñeå ñoùng hoäp thoaïi Define Frame Sections. 
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 Tieáp theo baïn haõy phoùng lôùn vuøng laøm vieäc ñeå nhìn thaáy treân phaàn töû daàm vaø coät ñaõ 
xuaát hieän nhö hình beân döôùi. 

 
Hình khi thöïc hieän xong 

Nhaáp choïn coâng cuï Zoom Out In One Step ñeå thu nhoû ñoái töôïng 

11. ÑÒNH NGHÓA TRÖÔØNG HÔÏP TAÛI VAØ GAÙN TAÛI TROÏNG CHO PHAÀN TÖÛ 

Khai baùo tröôøng hôïp tónh taûi : 

� Ñeå khai baùo tónh taûi ñaàu tieân 
baïn vaøo trình ñôn Define > 
Static Load Cases. 

 
 Hoäp thoaïi Define Static Load Case Names xuaát hieän. 

 
 Trong hoäp thoaïi Define Static Load Case Names baïn thöïc hieän khai baùo nhö sau : 

� Taïi muïc Load baïn nhaáp vaøo chuoãi kyù töï LOAD1, sau ñoù Change Load vaø nhaáp 
OK ñeå ñoùng hoäp thoaïi. 
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Khai baùo tröôøng hoäp taûi phaân boá. 

 Ñeå khai baùo taûi phaân boá, ñaàu tieân baïn choïn daàm taàng 1, 2, 3, 4 (caùch choïn daàm töông töï 
nhö caùch choïn trong böôùc 6 ñaùnh soá thöù töï) 

 
Choïn daàm taàng 1, 2, 3, 4 

� Tieáp theo baïn vaøo trình ñôn 
Assign > Frame Static 
Loads > Point and 
Uniform. 

 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 111 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

 Trong hoäp thoaïi Point and Uniform Span Loads baïn khai baùo theo trình töï sau: 

• Ñaàu tieân trong hoäp Load Case Name baïn duøng chuoät nhaáp vaøo tam giaùc 
beân phaûi ñeå choïn LOAD 1, sau ñoù taïi muïc Uniform Load nhaäp vaøo giaù trò 
–0.7 vaø nhaáp OK ñeå ñoùng hoäp thoaïi Point and Uniform Span Loads. 

 

Löïc phaân boá ñaõ xuaát hieän treân daàm 

 Khai baùo tröôøng hoäp taûi taäp trung : 

 Ñeå khai baùo taûi taäp trung tröôùc tieân baïn choïn daàm taàng 5, 6, 7, 8 caùch choïn töông töï nhö 
treân. 
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� Vaøo trình ñôn Assign > Frame Static Loads > Point and Uniform ñeå xuaát hieän 
hoäp thoaïi Point and Uniform Span Loads. 

 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 
• Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Uniform 

Load nhaäp vaøo giaù trò –0.6 vaø nhaáp OK ñeå ñoùng hoäp thoaïi Point and 
Uniform Span Loads. 

 
Hình khi thöïc hieän xong 
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12. CHOÏN CAÙC THOÂNG SOÁ CHO QUAÙ TRÌNH GIAÛI 

� Vaøo trình ñôn Analyse > Set Option. 

� Hoäp thoaïi Analysis Options xuaát hieän : 
 

 
 Trong hoäp thoaïi Analysis Options baïn khai baùo theo trình töï sau : 

� Trong muïc Fast DOFs nhaáp chuoät vaøo Plane Frame nhö hình con troû chæ beân 
treân. Nhaáp chuoät vaøo Generate Output ñeå keát quaû xuaát ra chuyeån vò. Nhaáp 
chuoät vaøo Select Output Options ñeå xuaát hieän hoäp thoaïi Select Output Results. 

Hoäp thoaïi Select Output Results xuaát hieän : 

 
Trong hoäp thoaïi Select Output Results baïn nhaáp chuoät vaøo Displacements vaø Select / 

Show Loads ñeå xuaát hieän hoäp thoaïi Select Output. 
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� Trong hoäp thoaïi Select Output baïn nhaáp chuoät vaøo LOAD 1 Load Case sau ñoù 
nhaáp choïn OK. 

� Nhaáp chuoät vaøo Reaction/Spring Forces sau ñoù nhaáp vaøo Select/ Show loads ñeå 
xuaát hieän hoäp thoaïi Select Output. 

Hoäp thoaïi Select Output xuaát hieän : 

 

� Trong hoäp thoaïi Select Output baïn nhaáp chuoät vaøo LOAD 1 Load Case sau ñoù 
nhaáp choïn OK. 

� Töông töï nhö treân, trong hoäp thoaïi Select Output Results baïn nhaáp choïn vaøo 
Frame Forces ñeå xuaát hieän hoäp thoaïi Select Output khi ñoù baïn nhaáp chuoät vaøo 
LOAD 1 Load Case vaø nhaáp choïn OK. 

� Nhaáp OK ñeå ñoùng hoäp thoaïi Select Output Results. 
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13. GIAÛI BAØI TOAÙN. 

� Ñeå giaûi baøi toaùn ñaàu tieân baïn 
vaøo trình ñôn Analyze > Run 
hay baïn nhaán phím F5 treân baøn 
phím. 

 

Khi ñoù baïn thaáy xuaát hieän hoäp thoaïi Save Model File As . 

 

Trong hoäp thoaïi Save Model File As trong muïc Save in baïn chæ ñöôøng daãn ñeå löu file, 
trong muïc File name baïn ñaëc teân cho file kaø “HIEU CHINH KHUNG”vaø nhaáp choïn Save ñeå 
file ñöôïc löu. 

 Khi nhaáp choïn Save maùy seõ töï ñoäng giaûi, khi quaù trình giaûi ñöôïc hoaøn taát baïn thaáy xuaát 
hieän hoäp thoaïi Analysis Complete nhö hình beân döôùi. 

 

 Neáu hoäp thoaïi baùo Error baïn phaûi thöïc hieän laïi baøi toaùn. 

 Trong hoäp thoaïi Analysis Complete baïn nhaáp choïn vaøo OK ñeå xem tröïc tieáp chuyeån vò 
cuûa khung. 
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Hình chuyeån vò cuûa khung 

14. HIEÅN THÒ SÔ ÑOÀ HÌNH HOÏC CAÙC KEÁT QUAÛ TÍNH TOAÙN  

� Ñeå hieån thò noäi löïc cuûa 
phaàn töû Frame ñaàu 
tieân vaøo trình ñôn 
Display > Show 
Element Forces / 
Stresses > Frames. 

 

Hoäp thoaïi Member Force Diagram for Frames xuaát hieän 

 

      Trong hoäp thoaïi Member Force Diagram for Frames 
baïn thöïc hieän khai baùo nhö sau : 

• Load : baïn duøng chuoät nhaáp choïn 
vaøo tam giaùc beân phaûi ñeå choïn 
LOAD 1 Load Case. 

• Trong muïc Component baïn choïn 
thaønh phaàn noäi löïc caàn hieån thò. 

• Nhaáp choïn vaøo Axial Force ñeå xem 
löïc doïc  

• Trong muïc Scaling nhaáp nhaáp choïn 
vaøo Auto ñeå maùy töï ñoäng ñaët moät tyû 
leä phuø hoäp . 

• Nhaáp choïn vaøo Fill Diagram hieån 
thò bieåu ñoà döôùi daïng toâ ñaëc. Vaø 
nhaáp choïn OK. 
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Bieåu ñoà löïc doïc 

� Tieáp theo baïn vaøo 
trình ñôn Display > 
Show Element 
Forces / Stresses > 
Frames. 

 

� Töông töï nhö treân 
trong hoäp thoaïi 
Member Force 
Diagram for Frames 
baïn nhaáp choïn vaøo 
Shear 2-2 vaø Show 
Values On Diagram 
ñeå xem löïc caét nhö 
hình beân döôùi. 
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 Thöïc hieän laïi böôùc treân vaø nhaáp choïn Moment 3-3 ñeå xem momen xoaén. 
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2. XEM DÖÕ LIEÄU DÖÔÙI DAÏNG HÌNH HOÏC 

Ñeå xem döõ lieäu ñaõ nhaáp baïn vaøo trình ñôn Dislpay > Show Input Table > Geometry 
Data. 

 

Hoäp thoaïi Display Geometry Options xuaát hieän : 

 

      Trong hoäp thoaïi Display Geometry Options taïi 
muïc Geometry Type baïn nhaáp chuoät vaøo Joint 
Data ñeå hieån thò döõ lieäu veà nuùt nhö hình beân döôùi. 
Baïn nhaáp chuoät vaøo thanh tröôït beân phaûi ñeå xem 
toaøn boä döõ lieäu veà nuùt. 

 

 Töông töï nhö vaäy trong hoäp thoaïi 
Display Geometry Options taïi muïc 
Geometry Type baïn nhaáp chuoät vaøo Joint 
Data ñeå hieån thò döõ lieäu veà phaàn töû vaø nhaáp 
choïn OK ñeå ñoùng hoäp thoaïi. 
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 Tieáp theo baïn vaøo trình ñôn Display > Show Input Tables > Loading Data. 

 
 Hoäp thoaïi Display Loading Options xuaát hieän : 

 

        Trong hoäp thoaïi Display Loading 
Options taïi muïc Load Name baïn nhaáp choïn 
vaøo LOAD 1, taïi muïc Load Type nhaáp choïn 
vaøo Frame Span Distributed Loads sau ñoù 
choïn OK ñeå ñoùng hoäp thoaïi. 
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BAØI TAÄP 5 

BAØI TOAÙN KHUNG PHAÚNG 
                                                                                                                                                                         

Trong baøi taäp naøy baïn seõ thöïc haønh giaûi baøi toaùn khung phaúng vôùi caùc soá lieäu ban ñaàu 
nhö sau : 

� Khung goàm 5 taàng, khoaûng caùch giöõa caùc taàng laø 5m. 

� Khung goàm 5 nhòp, khoaûng caùch giöõa caùc nhòp laø 4m. 

� Vaät lieäu laø beâ toâng coát theùp (BTCT) vôùi moâ ñun ñaøn hoài : E = 2.65106 T/m2. 

� Heä soá Poisson v = 0.2. 

� Troïng löôïng rieâng cuûa BTCT laø : 2.5 T/m3 

� Kích thöôùc cuûa coät 0.4 x 0.4. 

� Kích thöôùc cuûa daàm 0.3 x 0.4. 

� Löïc phaân boá taùc duïng leân taàng 1 vaø 2 laø 0.6 T /m 

� Löïc taùc duïng leân taàng 3 vaø 4,5 laø 0.5 T / m. 

 

Baèng chöông trình Sap 2000 baïn coù theå nhìn thaáy ñöôïc bieåu ñoà noäi löïc, phaûn löïc vaø keát 
quaû bieán daïng cuûa thanh daàm moät caùch nhanh choùng. Ñeå thöïc hieän ñöôïc ñieàu ñoù baïn haõy 
tieán haønh trình töï qua caùc böôùc sau : 
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1. KHÔÛI ÑOÄNG SAP 2000. 

� Töø trình ñôn Start choïn Programs > SAP 2000NonLinear. 

� Cöûa soå laøm vieäc xuaát hieän nhö hình sau : 

 

2. ÑÔN VÒ TÍNH. 

� Khai baùo ñôn vò tính laø Ton-m, baèng caùch baïn duøng chuoät nhaáp choïn vaøo tam 
giaùc beân phaûi phía döôùi cuûa maøn hình vaø choïn Ton-m. 

3. CHOÏN MAÃU KEÁT CAÁU. 

� Ñaàu tieân baïn vaøo trình ñôn File > New 
Model from Template ñeå môû hoäp 
thoaïi Model Template.  

 Hoäp thoaïi Model Templates xuaát hieän : 
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�  Trong hoäp thoaïi Model Templates baïn duøng chuoät nhaáp choïn vaøo maãu keát caáu 
thöù hai tính töø traùi qua nhö hình con troû chæ beân treân, ñaây laø heä khung phaúng 
trong maët phaúng X-Z, khi ñoù xuaát hieän hoäp thoaïi Portal Frame. 

  Hoäp thoaïi Portal Frame xuaát hieän : 

 

 Trong hoäp thoaïi Portal Frame, baïn tieán haønh khai baùo caùc thoâng soá nhö sau : 

� Ñaàu tieân nhaáp chuoät vaøo Rectraints ñeå boû choïn. 

 
� Taïi Number of Stories (soá taàng) nhaäp giaù trò : 5. 

� Taïi Number of Bays (soá nhòp) nhaäp giaù trò : 5. 

� Story Height chieàu cao taàng : 5 

� Trong hoäp Bay Width (beà roäng cuûa nhòp) nhaäp giaù trò laø 4. 

� Sau cuøng baïn nhaáp Ok ñeå ñoùng hoäp thoaïi Portal Frame. 

 

� Luùc naøy treân maøn hình cuûa baïn xuaát hieän hai cöûa soå laøm vieäc ñoù laø 3-D View vaø 
X-Y Plane @ Y= O, khi ñoù duøng chuoät nhaáp vaøo Close cuûa cöûa soå 3-D View ñeå 
ñoùng cöûa soå naøy. 
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Baïn seõ laøm vieäc vôùi cöûa soå X-Y Plane @ Y= O nhö hình beân döôùi goàm 5 taàng vaø 5 nhòp 

nhö baïn ñaõ khai baùo. 

Ñeå daáu ñi ñöôøng löôi baïn nhaán F7 treân baïn phím. 

 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 125 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

4. HIEÅN THÒ CAÙC THOÂNG SOÁ LEÂN MAØN HÌNH 

Caùc thoâng soá cuûa phaàn töû cho pheùp hieån thò moät caùch löïa choïn caùc ñaëc tröng khaùc nhau 
tuøy yù coù lieân quan ñeán caùc phaàn töû. Söû duïng phöông phaùp naøy ñeå hieån thò moät caùch löïa choïn caùc 
kieåu phaàn töû khaùc nhau coù lieân quan ñeán soá löôïng caùc thoâng soá cuûa phaàn töû, caùc loaïi hình ñaëc 
tröng tieát dieän cuûa phaàn töû vaø caùc tính chaát khaùc.  

Baïn cuõng coù theå daáu hay thu nhoû caùc phaàn töû. Vaäy phaàn töû laø gì? Theo moät soá khaùi nieäm 
cô baûn nhaát thì phaàn töû ñöôïc moâ taû nhö sau : Nhöõng keát caáu rôøi raïc taïo thaønh phaàn töû, tuy nhieân 
khoâng phaûi loaïi phaàn töû naøo cuõng gioáng nhau. Tuøy theo hình daïng, söï laøm vieäc cuûa töøng boä 
phaän keát caáu maø ngöôøi ta xaây döïng nhöõng phaàn töû thích hôïp ñeå ñaûm baûo caùc yeâu caàu veà söï 
töông thích. Ngoaøi ra ñeå phaân tích moät keát caáu böôùc ñaàu tieân laø rôøi raïc hoùa keát caáu ban ñaàu laø 
moät mieàn lieân tuïc thaønh caùc mieàn con thaät ñôn giaûn. Giöõa chuùng noái vôùi nhau thoâng qua moät soá 
ñieåm. Caùc mieàn con ñöôïc goïi laø phaàn töû, ñieåm noái ñeå lieân keát caùc phaàn töû goïi laø nuùt . 

Caùc phaàn töû ñöôïc phaân loaïi nhö sau: 

� Caùc daàm, coät trong heä khung ñöôïc moâ taû laø phaàn töû thanh daàm. 

� Baûn saøn nhaø, saøn maët caàu …  ñöôïc moâ taû laø phaàn töû taám, trong tröôøng hôïp khoâng 
gian, saøn, vaùch cöùng, maùi voøm, boàn chöùa…  ñöôïc moâ taû baèng phaàn töû taám voû toång 
quaùt, moät soá keát caáu maøng moûng duøng phaàn töû maøng. 

� Caùc keát caáu nhö ñaäp chaén, töôøng chaén, khi xem xeùt moät maët caét vôùi chieàu daøy 
ñôn vò neân söû duïng phaàn töû bieán daïng phaúng. Nhöõng lieân keá taám chòu taûi troïng 
neùn trong maët phaúng söû duïng phaàn töû öùng suaát phaúng. Keát caáu khoái moâ taû baèng 
phaàn töû khoái. 

Qua nhöõng khaùi nieäm treân chaéc raèng baïn ñaõ hình dung ñöôïc phaàn töû laø gì. Baïn haõy taäp 
laøm quen nhöõng thuïc ngöõ nhö phaàn töû, nuùt, baät töï do…  

� Ñeå hieån thò caùc thoâng soá cuûa phaàn töû 
leân maøn hình, ñaàu tieân baïn vaøo trình 
ñôn View > Set Elements hay nhaán toå 
hôïp phím Ctrl + E, ñeå xuaát hieän hoäp 
thoaïi Set Elements.  

Hoäp thoaïi Set Elements xuaát hieän : 
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 Trong hoäp thoaïi Set Elements baïn trình töï khai baùo caùc thoâng soá nhö sau : 

� Trong hoäp thoaïi Joints nhaáp chuoät vaøo Labels ñeå ñaùnh daáu choïn chöùc naêng hieån 
thò soá hieäu cuûa nuùt vaø phaàn töû. 

� Trong hoäp thoaïi Frames nhaáp chuoät vaøo Labels. 

� Sau cuøng baïn nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 

Khung ñöôïc hieån thò caùc thoâng soá. 

 Caùc thoâng soá xuaát hieän treân khung chính laø soá thöù töï daàm coät vaø nuùt, phaàn töû. 

 Neáu baïn tính baèng tay khoâng söû duïng phaàn meàm Sap thì quy öôùc khai baùo soá thöù töï nhö 
sau:  

� Ñoái vôùi nuùt thì baét ñaàu tính töø döôùi leân , töø traùi qua phaûi. 

� Ñoái vôùi phaàn töû baïn khai baùo coät tröôùc daàm sau. 

� Ñoái vôùi coät tính töø döôùi leân töø traùi qua phaûi. 

5. SÖÛ DUÏNG COÂNG CUÏ ZOOM 

� Ñeå phoùng lôùn vuøng laøm vieäc baïn duøng chuoät nhaáp choïn vaøo coâng cuï Zoom In 
One Step nhieàu laàn ñeán khi baïn nhìn thaáy roõ caùc thoâng soá treân khung phaúng nhö 
hình beân döôùi. Ngöôïc laïi neáu muoán thu nhoû baïn nhaáp vaøo Zoom Out One Step 
nhieàu laàn ñeå thu nhoû. 
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Hình khi ñöôïc phoùng lôùn. 

� Neáu muoán trôû laïi vuøng laøm 
vieäc ban ñaàu baïn nhaáp choïn 
vaøo Restore Full View.  

� Nhaáp chuoät vaøo coâng cuï Pan 
sau ñoù di chuyeån vaøo vuøng 
laøm vieäc, nhaán vaø giöõ chuoät 
ñeå di chuyeån maøn hình leân 
treân nhö hình sau. 
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6. KHAI BAÙO ÑIEÀU KIEÄN BIEÂN 

� Ñieàu kieän bieân cuûa moät nuùt laø söï khoáng cheá moät hay nhieàu thaønh phaàn chuyeån vò 
cuûa nuùt ñoù. Chaúng haïn nhö vieäc khoáng cheá caùc thaønh phaàn chuyeån vò xoay cuûa 
taát caû caùc nuùt trong keát caáu daøn, hay laø khoáng cheá caùc chuyeån vò töông öùng vôùi 
caùc lieân keát (goái, khôùp, ngaøm) cuûa keát caáu. 

 Trong baøi taäp treân laø 6 nuùt lieân keát vôùi ñaát. 

 

�  Baây giôø baïn haõy khai baùo ñieàu kieän bieân, ñeå khai baùo ñieàu kieän bieân ñaàu tieân 
choïn caùc nuùt döôùi cuøng baèng caùch :  

� Nhaáp chuoät vaøo trình töï caùc nuùt soá 1, 7, 13, 19, 25, 31. 

� Khi nhaáp chuoät vaøo caùc nuùt, baïn seõ thaáy nhöõng daáu cheùo xuaát hieän treân nuùt coù 
nghóa laø nuùt ñoù ñaõ ñöôïc choïn nhö hình beân döôùi. 

 

Saùu nuùt ñaõ ñöôïc choïn. 
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�  Vaøo trình ñôn Assign > Joint > Restraints. 

 

Hoäp thoaïi Joint Restraints xuaát hieän : 

 

 Trong hoäp thoaïi Joint Restraints taïi muïc Fast Restraints baïn duøng chuoät nhaáp choïn 
vaøo Tab ñaàu tieân nhö hình con troû chæ beân treân vì theo döõõ lieäu ban ñaàu cuûa baøi toaùn laø lieân keát 
ngaøm vôùi ñaát. 

Sau cuøng baïn nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

 

Lieân keát ngaøm xuaát hieän 

7. KHAI BAÙO CAÙC ÑAËC TRÖNG VAÄT LIEÄU 

� Ñaàu tieân baïn vaøo trình ñôn 
Define > Materials ñeå hieån thò 
hoäp thoaïi Define Materials 
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 Hoäp thoaïi Define Materials xuaát hieän : 

 

 Trong hoäp thoaïi Define Materials taïi muïc Materials baïn nhaáp chuoät vaøo CONC (vaät 
lieäu laø beâ toâng coát theùp), trong hoäp Click to nhaáp chuoät vaøo Modify / Show Material ñeå xuaát 
hieän hoäp thoaïi Material Property Data. 

 

Trong hoäp thoaïi Material Property Data taïi muïc Analysis Property Data baïn tieán 
haønh khai baùo nhö sau : 

• Mass per unit Volume nhaäp vaøo giaù trò : 0 (troïng löôïng rieâng) 

• Weight per unit Volume baïn nhaäp vaøo giaù trò : 2.5 (khoái löôïng rieâng cuûa beâ toâng 
coát theùp) 

• Modulus of elasticity : 2.65e6 (heä soá moâ ñun ñaøn hoài)  

Chuù yù : Khi nhaäp heä soá moâ ñun ñaøn hoài baïn neân nhaäp baèng baøn phím beân phaûi  

• Poissons ratio : 0.2 (heä soá poisson). 

• Tieáp theo nhaáp choïn OK ñeå ñoùng hoäp thoaïi Material Property Data. 

• Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Materials. 
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8. KHAI BAÙO CAÙC ÑAËC TRÖNG VEÀ HÌNH HOÏC  

Ñoái vôùi baøi toaùn treân baïn khai baùo caùc ñaëc tröng cuûa daàm vaø cuûa coät. 

Khai baùo cho coät : 

� Ñaàu tieân baïn vaøo trình ñôn 
Define > Frame Sections. 

 

 Hoäp thoaïi Define Frame Sections xuaát hieän : 

 

 Trong hoäp thoaïi Define Frame Sections baïn thöïc hieän khai baùo nhö sau : 

� Taïi muïc Click to baïn duøng chuoät nhaáp choïn vaøo tam giaùc beân phaûi cuûa hoäp Add/ 
Wide Flange ñeå choïn Add Rectanuglar nhö hình beân döôùi, khi ñoù baïn thaáy xuaát 
hieän hoäp thoaïi Rectangular Section. 
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 Hoäp thoaïi Rectangular Section xuaát hieän : 

 

 Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau : 

� Taïi muïc Section Name baïn nhaäp teân “COT”. 

� Trong muïc Dimensions khai baùo tieát dieän cho coät baèng caùch nhaäp giaù trò vaøo muïc 
Depth laø 0.4, vaø muïc Width laø 0.4. 

� Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu laø 
CONC(coät beâ toâng coát theùp). 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 

� Nhaáp OK laàn hai ñeå ñoùng hoäp thoaïi Define Frame Sections. 

Khai baùo cho daàm : 
Vaøo trình ñôn Define > Frame Sections. 
Hoäp thoaïi Define Frame Sections xuaát hieän : 
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 Trong hoäp thoaïi Define Frame Sections taïi muïc Click to baïn duøng chuoät nhaáp choïn vaøo 
tam giaùc beân phaûi cuûa hoäp Add / Wide Flange ñeå choïn Add Rectanular nhö hình beân döôùi ñeå 
hieån thò hoäp thoaïi Rectangular Section. 

 
 Hoäp thoaïi Rectangular Section xuaát hieän : 

 
 Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau: 

� Taïi muïc Section Name baïn nhaäp teân “DAM”. 

� Trong muïc Dimensions khai baùo tieát dieän cho coät baèng caùch nhaäp giaù trò vaøo muïc 
Depth laø 0.4, vaø muïc Width laø 0.3. 

� Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu laø 
CONC. 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 

� Luùc naøy trong hoäp thoaïi Define Frame Sections baïn thaáy trong hoäp Name ñaõ 
xuaát hieän COT, DAM maø baïn ñaõ khai baùo trong phaàn treân. 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 134 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

 
� Nhaáp OK ñeå ñoùng hoäp thoaïi Define Frame Sections. 

9. GAÙN ÑAËC TRÖNG CHO PHAÀN TÖÛ 

Gaùn ñaëc tröng cho phaàn töû laø gì? Nghe sao khoù hieåu quaù phaûi khoâng baïn? Vì nhöõng phaàn 
töû treân khung luùc baây giôø chöa coù teân. Baây giôø baïn haõy gaùn cho noù moät caùi teân ñi, ñeå gaùn ñaëc 
tröng cho phaàn töû ñaàu tieân baïn seõ khai baùo cho coät. Ñeå khai baùo cho coät baïn thöïc hieän theo trình 
töï sau: 

� Ñaàu tieân baïn nhaáp vaøo coâng cuï Restore Full View ñeå cheá ñoä maøn hình trôû veå 
cheá ñoä nhìn ban ñaàu. 

� Choïn taát caû caùc coät baèng caùch treân thanh coâng cuï baïn duøng chuoät nhaáp vaøo b ieåu 

töôïng  sau ñoù di chuyeån chuoät vaøo vò trí khung treân cuøng nhaáp vaø giöõ chuoät 
keùo moät ñöôøng thaúng ngang qua taát caû coät treân taàng treân nhö hình sau: 

 

  

Vò trí nhaáp chuoät 
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Veõ ñöôøng thaúng ngang qua coät cuûa taàng treân 

 Töông töï nhö vaäy baïn thöïc hieän tieáp theo cho taát caû coät cuûa taàng coøn laïi baèng caùch choïn 

coâng cuï coù bieåu töôïng  nhaán vaø giöõ chuoät ôû taàng keá tieáp taïo moät ñöôøng thaúng ngang qua 
caùc coät. 

 

Veõ ñöôøng thaúng ngang qua coät cuûa taàng keá tieáp 
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Taát caû coät ñaõ ñöôïc choïn 

 Ñöôøng thaúng ngang qua caây coät naøo thì caây coät ñoù trôû thanh ñöôøng coù neùt ñöùt vì vaäy 
trong quaù trình thöïc hieän neáu baïn khoâng thaáy coät xuaát hieän nhöõng neùt ñöùt thì baïn haõy thöïc hieän 
laïi. 

� Baây giôø baïn vaøo trình ñôn Assign > Frame > Sections ñeå xuaát hieän hoäp thoaïi 
Define Frame Sections. 

 Hoäp thoaïi Define Frame 
Sections xuaát hieän. 

 
 Trong hoäp thoaïi Define Frame Sections taïi muïc Name baïn duøng chuoät nhaáp vaøo chuoãi 
kyù töï COT sau ñoù nhaáp vaøo OK ñeå ñoùng hoäp thoaïi. 
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 Luùc naøy treân khung xuaát hieän nhöõng 
doøng chöõ nhöng vì nhoû qua baïn khoâng nhìn 
thaáy ñöôïc. Ñeå nhìn thaáy nhöõng doøng chöõ laø gì 
baïn vaøo trình ñôn View > Previous Zoom. 

 

 

 Baây giôø nhöõng doøng chöõ COT ñaõ xuaát hieän treân khung nhö hình beân treân. Tieáp theo ñeã 
xuaát hieän daàm baïn thöïc hieän nhö sau. 

�  Choïn daàm, ñeå choïn daàm ñaàu tieân vaøo trình ñôn View >Restore Full View hay 
baïn nhaán phím F3 treân baøn phím. 

 

 Tieáp theo di chuyeån chuoät vaøo vuøng laøm vieäc sau ñoù nhaán vaø giöõ chuoät taïi vò trí nhö hình 
beân döôùi, keùo theo ñuôøng cheùo ñeå taïo hình chöõ nhaät bao phuû toaøn boä daàm ngang. 
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Vò trí nhaáp chuoät  

 
Hình taïo vuøng choïn  

 Luùc baây giôø sau khi thaû chuoät ra baïn seõ thaáy taïi caùc nuùt xuaát hieän daáu cheùo nhö hình sau. 

 
Daàm treân cuøng ñaõ ñöôïc choïn 
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Töông töï nhö vaäy baïn thöïc hieän tieáp cho nhöõng daàm keá tieáp baèng caùch taïo vuøng choïn 
cho nhöõng daàm coøn laïi.  

 

Hình khi taïo vuøng choïn  
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 Hình khi thöïc hieän xong 

�  Tieáp theo vaøo trình ñôn Assign > Frame > Section 

 

 Hoäp thoaïi Define Frame Sections xuaát hieän : 
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 Trong hoäp thoaïi Define Frame Sections taïi muïc Name baïn duøng chuoät nhaáp choïn vaøo 
DAM sau ñoù nhaáp vaøo OK ñeå hoäp thoaïi Define Frame Sections ñoùng laïi. 

 
Daàm ñaõ xuaát hieän treân khung 

10. KHAI BAÙO TAÛI TROÏNG 

Khai baùo tröôøng hôïp tónh taûi 

� Ñeå khai baùo tónh taûi ñaàu tieân 
baïn vaøo trình ñôn Define Static 
Load Cases. 

 

 Hoäp thoaïi Define Static Load Case Names xuaát hieän : 
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 Trong hoäp thoaïi Define Static Load Case Names baïn thöïc hieän khai baùo nhö sau : 

 
� Taïi muïc Load baïn nhaäp vaøo chuoãi kyù töï TINH TAI, sau ñoù nhaáp chuoät vaøo 

Change Load vaø nhaáp OK ñeå vieäc nhaäp teân ñöôïc thöïc hieän. 

Gaùn löïc phaân boá cho caùc daàm. 

� Ñeå gaùn phaàn töû do daàm ñaàu tieân baïn choïn phaàn töû cuûa daàm taàng 1 vaø daàm taàng 2, 
baèng caùch nhaáp vaø giöõ chuoät taïi vò trí daàm taàng moät nhö hình beân döôùi, sau ñoù 
keùo xieân chuoät qua phaûi ñeå taïo vuøng choïn bao phuû toaøn boä daàm taàng moät vaø thaû 
chuoät ra. 

 

Vò trí nhaáp chuoät 
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 Töông töï nhö vaäy, baïn thöïc hieän cho daàm taàng hai. 

 

 
Hình khi choïn daàm taàng moät vaø taàng hai. 

�  Tieáp theo baïn vaøo trình ñôn Assign > Frame Static Loads > Point and Uniform. 

 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 144 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 

 Trong hoäp thoaïi Point and Uniform Span Loads baïn khai baùo theo trình töï sau: 

 Ñaàu tieân trong hoäp Load Case Name baïn duøng chuoät nhaáp vaøo tam giaùc beân phaûi ñeå 
choïn TINH TAI, sau ñoù taïi muïc Uniform Load nhaäp vaøo giaù trò –0.6 laø (löïc phaân boá ñeàu giöõ 
lieäu ban ñaàu) vaø nhaáp OK ñeå ñoùng hoäp thoaïi Point and Uniform Span Loads. 

 Baây giôø baïn thaáy löïc phaân boá ñaõ xuaát hieän treân taàng 1 vaø taàng 2 nhö hình beân döôùi, löïc 
phaân boá xuaát hieän maøu vaøng.  

 

 Tieáp theo baïn gaùn löïc phaân boá cho daàm taàng 3, 4, 5 baèng caùch choïn töøng daàm, caùch choïn 
töông töï nhö treân, daàm naøo ñöôïc choïn baïn seõ thaáy xuaát hieän daáu gaïch cheùo nhö hình sau : 
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Daàm taàng 3,4,5 ñöôïc choïn. 

�  Tieáp theo baïn vaøo trình ñôn Assign > Frame Static Loads > Point and Uniform. 

Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 

 Trong hoäp thoaïi Point and Uniform Span Loads baïn thöïc hieän khai baùo nhö sau : 
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9 Ñaàu tieân trong hoäp Load Type Case Name baïn nhaáp chuoät vaøo tam giaùc 
beân phaûi ñeå choïn TINH TAI. 

9 Trong hoäp Load Type and Direction nhaáp chuoät vaøo Forces taïi muïc 
Direction nhaáp vaøo tam giaùc ñeå choïn GlobalZ. 

9 Taïi muïc Uniform Load nhaäp giaù trò : -0.5. Sau cuøng nhaáp choïn vaøo OK 
ñeå ñoùng hoäp thoaïi. 

 
Löïc phaân boá xuaát hieän treân khung  

  Ñeå kieåm tra löïc phaân boá coù ñuùng nhö baïn khai baùo 
khoâng, baïn thöïc hieän theo trình töï sau : Choïn coâng cuï Rubber 
Band Zoom nhaán vaø giöõ chuoät vaøo vò trí nhö hình beân döôùi 
sau ñoù taïo moät vuøng choïn bao phuû. 
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Hình khi taïo vuøng bao phuû 

 

Hình khi thaû chuoät  

�  Luùc naøy treân khung seõ xuaát hieän giaù trò cuûa löïc phaân boá nhö hình treân. 

� Tieáp theo vaøo trình ñôn View > Restore Full View hay nhaán F3 treân baøn phím ñeå 
vuøng laøm vieäc trôû laïi ban ñaàu. 
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11. KHAI BAÙO BAÄT TÖÏ DO 

� Söï bieán daïng cuûa keát caáu khi chòu taùc duïng cuûa ngoaïi löïc, ñöôïc bieåu dieãn qua söï 
chuyeån vò cuûa caùc nuùt. Ñoái vôùi keát caáu khoâng gian trong tröôøng hôïp toång quaùt moät 
nuùt coù saùu thaønh phaàn chuyeån vò : 

Baät töï do cuûa moät nuùt töông öùng vôùi thaønh phaàn chuyeån vò cuûa moät nuùt goàm coù: 

• 3 thaønh phaàn chuyeån vò thaúng 
ñöùng theo 3 truïc 1, 2, 3 cuûa heä 
toaï ñoä rieâng (U1, U2, U3) 

• 3 thaønh phaàn chuyeån vò xoay 
quanh ba truïc 1, 2, 3 cuûa heäâ toïa 
ñoä rieâng (R1, R2, R3).  

• Moät thaønh phaàn chuyeån vò coù hai traïng thaùi : coù theå coù chuyeån vò hay bò khoáng 
cheá hay khoâng chuyeån vò. Ñoái vôùi caùc phaàn töû maãu töông öùng vôùi caùc moâ hình 
phaân tích khaùc nhau thì soá thaønh phaàn chuyeån vò cuûa moät nuùt töông öùng cuõng 
khaùc nhau, noù phuï thuoäc vaøo söï laøm vieäc cuûa phaàn töû ñoù. Soá thaønh phaàn chuyeån 
vò cuûa moät nuùt ñöôïc goïi laø baät töï do cuûa nuùt. Maëc ñònh höôùng cuûa caùc truïc 1, 2, 3 
cuûa moät nuùt seõ song song vôùi höôùng cuûa caùc truïc X, Y, Z. 

• Qua khaùi nieäm treân chaéc haún baïn ñaõ hieåu ñöôïc theá naøo laø baät töï do.  

� Baây giôø ñeå khai baùo baät töï do 
ñaàu tieân vaøo trình ñôn Analyze 
> Set Options. 

 
Hoäp thoaïi Analyze Options xuaát hieän : 
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 Trong hoäp thoaïi Analyze Options baïn khai baùo theo trình töï sau. 

� Trong muïc Fast DOFs nhaáp chuoät vaøo Plane Frame nhö hình con troû chæ beân 
treân. 

� Nhaáp chuoät vaøo Generate Output ñeå keát quaû xuaát ra chuyeån vò. 

� Nhaáp chuoät vaøo Select Output Options ñeå hieån thò hoäp thoaïi Select Output 
Results. 

Hoäp thoaïi Select Output Results xuaát hieän : 

 

Trong hoäp thoaïi Select Output Results baïn nhaáp chuoät vaøo Displacements vaø Select / 
Show Loads ñeå xuaát hieän hoäp thoaïi Select Output. 

� Trong hoäp thoaïi Select Output 
baïn nhaáp chuoät vaøo TINH TAI 
Load Case sau ñoù nhaáp choïn 
OK. 

 
� Nhaáp chuoät vaøo Reaction/Spring Forces sau ñoù nhaáp vaøo Select/ Show loads ñeå 

xuaát hieän hoäp thoaïi Select Output. 

THIEÁT KEÁ VÔ
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� Trong hoäp thoaïi Select Output baïn nhaáp chuoät vaøo TINH TAI Load Case sau ñoù 
nhaáp choïn OK. 

� Töông töï nhö treân trong hoäp thoaïi Select Output Results baïn nhaáp choïn vaøo 
Frame Forces ñeå xuaát hieän hoäp thoaïi Select Output khi ñoù baïn nhaáp chuoät vaøo 
TINH TAI Load Case vaø nhaáp choïn OK. 

� Nhaáp OK ñeå ñoùng hoäp thoaïi Select Output Results. 

12. KHAI BAÙO SOÁ PHAÂN ÑOAÏN CHO PHAÀN TÖÛ 

� Ñaàu tieân treân thanh coâng cuï baïn nhaáp choïn bieåu töôïng all. 

 

 
Hình khi nhaáp choïn vaøo all 

� Vaøo trình ñôn Assign > Frame > Output Segments 
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Hoäp thoaïi Frame Output Segments xuaát hieän : 

 

   Trong hoäp thoaïi Frame Output Segments 
taïi muïc Number Of Segments baïn nhaäp giaù 
trò laø 4 vaø nhaáp choïn OK. 

 GIAÛI BAØI TOAÙN 

Ñeå giaûi baøi toaùn ñaàu tieân baïn duøng 
chuoät nhaáp choïn vaøo Analyze > Run hoaëc 
nhaán phím F5 treân baøn phím.  

Baây giôø baïn thaáy xuaát hieän hoäp thoaïi Save Model File As . 

 

Trong hoäp thoaïi Save Model File As taïi muïc Save in baïn chæ ñöôøng daãn ñeå löu file, 
trong muïc File name baïn ñaët teân cho file kaø “khung phang”vaø nhaáp choïn Save ñeå file ñöôïc löu. 
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Luùc naøy maùy seõ töï ñoäng giaûi baøi toaùn ñeán khi chöông trình ngöøng thöïc hieän baïn phaûi xem 
Sap coù baùo loãi hay khoâng, baèng caùch keùo thanh tröôït beân phaûi ñeå hieån thò caùc thoâng baùo. 
 Neáu thaáy baát kyø Error naøo thì coù nghóa soá lieäu taïi nôi ñoù baïn ñaõ khai baùo sai, vì vaäy baïn 
caàn kieåm tra laïi. Baøi toaùn khoâng coù loãi khi chöông trình thoâng baùo haøng chöõ Analysis Complete 
ôû cuoái file. 

13. XEM KEÁT QUAÛ BAØI TOAÙN 

Sau khi tính toaùn ñaõ hoaøn taát xong, baïn nhaáp choïn vaøo OK cuûa hoäp Analysis Complete ñeå 
hieån thò tröïc tieáp keát quaû chuyeån vò nhö hình beân döôùi. 

 
Keát quaû chuyeån vò 

14. XEM HÌNH DAÏNG BAN ÑAÀU 

Ñeå xem hình daïng ban ñaàu cuûa khung baïn vaøo trình ñôn Display > Show Undeformed 
Shape hay nhaán F4 treân baøn phím. 
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Hình daïng ban ñaàu cuûa baøi toaùn khung 

15. XEM PHAÛN LÖÏC 

Ñeå xem noäi löïc taïi caùc lieân keát noái vôùi ñaát ñaàu tieân vaøo trình ñôn Display > Show Elemect 
Forces / Stresses >Joints. 
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Hoäp thoaïi Joint Reaction Forces xuaát hieän : 

  

   Trong hoäp thoaïi Joint Reaction Forces baïn 
khai baùo theo trình töï sau : 

� Taïi muïc Load baïn duøng chuoät 
nhaáp choïn vaøo tam giaùc beân 
phaûi ñeå choïn TINH TAI Load 
Case. 

� Nhaáp chuoät vaøo Reactions 

� Nhaáp chuoät vaøo nuùt  OK ñeå 
ñoùng hoäp thoaïi Joint Reaction 
Forces. 

 
        Khi thöïc hieän xong ñeå thaáy roõ phaûn löïc 
taïi goái baïn nhaáp chuoät vaøo coâng cuï Rubber 
Band Zoom, nhaán giöõ chuoät vaø keùo chuoät ñeå 
taïo moät vuøng choïn bao phuû toaøn boä phaàn beân 
döôùi vaø thaû nuùt chuoät ra nhö hình sau:  
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Hình khi taïo vuøng choïn bao phuû  

 
Hình khi thaû chuoät  

Sau khi xem keát quaû hieån thò noäi löïc taïi lieân keát noái vôùi ñaát baïn nhaán F3 treân baøn phím 
ñeå trôû veå vuøng laøm vieäc ban ñaàu. 

16. HIEÅN THÒ NOÄI LÖÏC CUÛA PHAÀN TÖÛ FRAME 

Ñeå hieån thò noäi löïc taïi phaàn töû cuûa Frame baïn vaøo trình ñôn Display > Show Element 
Forces / Stresses >Frame. 

 

Hoäp thoaïi Member Force Diagram for Frames xuaát hieän : 
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    Trong hoäp thoaïi Member Force Diagram 
for Frames taïi muïc Load nhaáp chuoät vaøo tam 
giaùc beân phaûi ñeå choïn tröôøng hoäp taûi troïng laø 
TINH TAI Load Case.  

    Taïi muïc Component nhaáp chuoät vaøo 
Moment 3-3 (moment xoaén taïi truïc ñòa 
phöông 3-3).  

    Nhaáp choïn vaøo Fill Diagram ñeå hieån thò 
bieåu ñoà döôùi daïng maøu ñöôïc toâ daày. 

 

Hình khi thöïc hieän 

17. HIEÅN THÒ TAÛI TROÏNG TAÏI PHAÀN TÖÛ FRAME 

Ñeå hieån thò taûi troïng vaø giaù trò töông öùng taùc duïng leân phaàn töû Frame, tröôùc tieân vaøo trình 
ñôn Display > Show Loads > Frame. 
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Hoäp thoaïi Show Frame Loads xuaát hieän : 

 

 Trong hoäp thoaïi Show Frame Loads 
baïn thöïc hieän khai baùo nhö sau : 

� Taïi muïc Load Name nhaáp 
chuoät vaøo tam giaùc beân phaûi ñeå 
choïn TINH TAI. 

� Trong muïc Load Type nhaáp 
chuoät vaøo Span Loading 
(Forces) ñeå hieån thò taûi troïng, 
löïc taùc duïng leân phaàn töû. 

� Nhaáp chuoät vaøo Show Loading 
Values ñeå hieån thò giaù trò cuûa 
taûi troïng. 

� Nhaáp choïn OK. 

 
Hình khi thöïc hieän 
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18. XEM DÖÕ LIEÄU ÑÖA VAØO NHÖ SÔ ÑOÀ HÌNH HOÏC 

Soá lieäu veà nuùt: 

Ñeå xem döõ lieäu ñaõ nhaáp baïn vaøo trình ñôn Display > Show Input Tables > Geometry 
Data. 

 
Hoäp thoaïi Display Geometry Options xuaát hieän : 

 

Trong hoäp thoaïi Display Geometry Options 
taïi muïc Geometry Type baïn nhaáp chuoät vaøo 
Joint Data ñeå hieån thò döõ lieäu veà nuùt sau ñoù 
nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 

Giaûi thích baûng keát quaû Joint Data: 

� JOINT : soá thöù töï veà nuùt. 

� GLOBAL toaï ñoä nuùt theo heä toaï ñoä toång theå. 

� RESTRAINTS hieån thò ñieàu kieän bieân.  

� ANGLE giaù trò goùc xuaát hieän khi goái bò xoay. 

� Nhaáp chuoät vaøo thanh tröôït beân phaûi ñeå xem taát caû nhöõng giaù trò. Nhaáp chuuoät 
vaøo nuùt Close goùc treân beân phaûi ñeå ñoùng hoäp thoaïi Joint Data. 
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Soá lieäu veà phaàn töû : 

Vaøo trình ñôn Display > Show Input Tables > Geometry Data. 

 
Hoäp thoaïi Display Geometry Options xuaát hieän : 

 

Trong hoäp thoaïi Display Geometry Options 
baïn duøng chuoät nhaáp choïn vaøo Frame 
Element Data vaø nhaáp OK ñeå xuaát hieän baûng 
giaù trò Frame Element Data. 

 

 Trong baûng Frame Element Data: 

� FRAME : Soá thöù töï phaàn töû. 

� JNT –1 : Nuùt ñaàu. 

� JNT –2 : Nuùt cuoái. 

� SECTION : Vaät lieäu coät , daàm. 

� ANGLE : goùc cuûa phaàn töû khi coät , daàm bi nghieâng. 
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� RELEASES : thaønh phaàn löïc ñöôïc giaûi phoùng. 

� SEGMENTS : soá phaân ñoaïn 

� R : chieàu daøi cuûa ñoaïn lieân keát cöùng  

Soá lieäu veà taûi troïng : 

Vaøo trình ñôn Dislpay > Show Input Tables > Loading Data. 

 
 Hoäp thoaïi Display Loading Options xuaát hieän : 

 

Trong hoäp thoaïi Display Loading Options taïi 
muïc Load Name nhaáp chuoät vaøo tam giaùc beân 
phaûi ñeå choïn TINH TAI 

 Tieáp theo trong muïc Load Type nhaáp choïn 
vaøo Frame Span Distributed Loads vaø nhaáp 
choïn OK ñeå baûng giaù trò FRAME SPAN 
DISTRIBUTED LOADS Load Case TINH 
TAI xuaát hieän. 

 
 Trong baûng FRAME SPAN DISTRIBUTED LOADS Load Case TINH TAI : 

� TYPE    : Kieåu löïc hoaëc moment 

� DIRECTION   : Phöông cuûa taûi troïng. 
Chuùc möøng baïn ñaõ hoaøn taát baøi taäp naøy.  
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BAØI TAÄP 6 

KHUNG KHOÂNG GIAN 
� Cho heä khung goàm 4 taàng, khoaûng caùch giöõa caùc taàng laø 4m. 

� Soá nhòp theo phöông X laø 2 

� Soá nhòp theo phöông Y laø 2 

� Beà roäng nhòp theo phöông X laø 5m 

� Beà roäng nhòp theo phöông Y laø 5m 

� Vaät lieäu laø beâ toâng coát theùp (BTCT) vôùi moâ ñun ñaøn hoài: E = 2.65106 T/m2. 

� Heä soá Poisson v = 0.2. 

� Troïng löôïng rieâng cuûa BTCT laø : 2.5 T/m3 

� Kích thöôùc cuûa coät taàng 1 vaø 2 laø 0.4 x 0.4. 

� Kích thöôùc cuûa coät taàng 3 vaø 4 laø 0.3 x 0.3 

� Kích thöôùc cuûa daàm taàng 1 vaø 2 laø 0.3 x 0.4. 

� Kích thöôùc cuûa daàm taàng 3 vaø 4 laø 0.2 x 0.4. 

� Löïc phaân boá taùc duïng leân taàng 1 vaø 2 laø 0.8 T / m. 

 
Khung khoâng gian 

Vôùi soá lieäu baøi toaùn ban ñaàu, baïn haõy tieán haønh giaûi baøi toaùn theo trình töï sau : 
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1. KHÔÛI ÑOÄNG SAP 2000 

Töø trình ñôn Start choïn Programs > SAP 2000NonLinear. 

2. CHOÏN ÑÔN VÒ TÍNH TOAÙN 

      Nhaáp chuoät vaøo tam giaùc beân phaûi cuoái 
maøn hình ñeå choïn ñôn vò laø Ton-m. 

 
3. TAÏO MOÄT MOÂ HÌNH MAÃU 

     Ñeå taïo moâ hình maãu ñaàu tieân baïn vaøo 
trình ñôn File > New Model from Template. 

 
Hoäp thoaïi Model Template xuaát hieän :  

 
Trong hoäp thoaïi Model Template baïn duøng chuoät nhaáp choïn vaøo maãu thöù baûy nhö hình 

con troû chæ beân treân ñeå xuaát hieän hoäp thoaïi Space Frame. 

 Hoäp thoaïi Space Frame xuaát hieän : 
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 Trong hoäp thoaïi Space Frame baïn khai baùo theo trình töï sau : 

• Nhaáp chuoät vaøo Restraints ñeå boû choïn 

• Number of Stories (soá taàng) : 4 

• Number of Bays along X (soá nhòp theo phöông X) : 2 

• Number of Bays along Y (soá nhòp theo phöông Y) : 2 

• Story Height ( chieàu cao taàng) : 4 

• Bay width along X (beà roäng nhòp theo phöông X) : 5 

• Bay width along Y(beà roäng nhòp theo phöông Y) : 5 

• Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

Baây giôø treân maøn hình xuaát hieän hai cöûa soå laøm vieäc khi ñoù baïn duøng chuoät nhaáp choïn 
vaøo Close ñeå ñoùng cöûa soå coù teân X-Y Plane @Z=16 nhö hình sau: 

 

 
Hình khi hoaøn taát 
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Tieáp theo baïn goïi leänh View > Set 3D 
View hay nhaán toå hôïp phím Shift + F3. 

 
 Hoäp thoaïi Set 3D View xuaát hieän : 

 

 Trong hoäp thoaïi Set 3D View trong muïc View Direction Angle baïn nhaäp giaù trò vaøo nhö 
sau : Plan :-79, Elevation : 10, Apetrue : 0 sau ñoù nhaáp choïn OK ñeå ñoùng hoäp thoaïi 3D View 
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4. HIEÅN THÒ CAÙC THOÂNG SOÁ 

   Ñeå hieån thò thoâng soá leân khung baïn vaøo 
trình ñôn View > Set Elements hay nhaán toå 
hôïp phím Ctrl+E. 

 

Hoäp thoaïi Set Elements xuaát hieän : 

 

 Trong hoäp thoaïi Set Elements baïn trình töï khai baùo caùc thoâng soá: 

• Trong hoäp thoaïi Joints nhaáp chuoät vaøo Labels  

• Trong hoäp thoaïi Frames nhaáp chuoät vaøo Labels. 

• Sau cuøng baïn nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

 

Soá hieån thò leân khung 
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5. KHAI BAÙO ÑIEÀU KIEÄN BIEÂN 

� Ñeå khai baùo ñieàu kieän bieân, ñaàu tieân 
baïn duøng chuoät nhaáp choïn vaøo coâng cuï 
Rubber Band Zoom, sau ñoù di chuyeån 
chuoät vaøo vuøng laøm vieäc theo vò trí nhö 
hình con troû chæ beân döôùi. 

 

 
 Baây giôø nhaán giöõ chuoät vaø keùo theo ñöôøng cheùo ñeå taïo vuøng choïn bao phuû toaøn boä 6 nuùt 
beân traùi nhö hình beân döôùi, sau ñoù baïn thaû chuoät ra nhö hình sau: 

 
Taïo vuøng choïn 

 
Hình khi ñöôïc phoùng lôùn 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 167 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 
� Theo baøi toaùn ban ñaàu cho hai loaïi lieân keát ñoù laø ngaøm vaø goái coá ñònh do vaäy baïn khai 

baùo cho nuùt hai laàn  

Lieân keát ngaøm : 

• Tröôùc tieân baïn duøng chuoät nhaáp choïn töøng nuùt 1, 6, 11, 16, 21, 26, khi baïn 
nhaáp choïn vaøo nuùt naøo thì taïi nuùt ñoù xuaát hieän moät daáu cheùo nhö hình sau. 

Chuù yù : baïn phaûi nhaáp chuoät ñuùng vaøo nuùt, khoâng nhaáp vaøo coät neáu baïn choïn nhaàm baïn duøng 
chuoät nhaáp vaøo chính nôi ñoù moät laàn nöõa. 

 

Hình khi choïn 9 nuùt 

 Baây giôø baïn vaøo trình ñôn Assign > 
Joint > Restraints. 

 

 Hoäp thoaïi Joint Restraints xuaát hieän. 

 

        Trong hoäi thoaïi Joint Restraints taïi muïc 
Fast Restraints baïn duøng chuoät nhaáp vaøo Tab 
ñaàu tieân nhö hình con troû chæ beân treân vaø nhaáp 
choïn OK ñeå ñoùng hoäp thoaïi Joint Restraints. 

 
Lieân keát ngaøm ñaõ xuaát hieän 
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Lieân keát goái coá ñònh : 

• Töông töï nhö treân baïn duøng chuoät nhaáp choïn vaøo nuùt 31, 36, 41 sau ñoù 
vaøo trình ñôn Assign > Joint > Restraints. 

Hoäp thoaïi Joint Restraints xuaát hieän. 

 

 Trong hoäp thoaïi Joint Restraints taïi muïc Fast Restraints nhaáp chuoät vaøo Tab thöù hai 
tính töø traùi qua.  

 

Lieân keát goái xuaát hieän 

    Ñeå vuøng laøm vieäc trôû laïi cheá ñoä nhìn 
ban ñaàu baïn vaøo trình ñôn View > Previous 
Zoom 
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6. KHAI BAÙO ÑAËC TRÖNG VAÄT LIEÄU 

      Ñeå khai baùo ñaëc tröng veà vaät lieäu baïn vaøo 
trình ñôn Define > Materials ñeå xuaát hieän hoäp 
thoaïi Define Materials. 

 

Hoäp thoaïi Define Materials xuaát hieän. 

 

Trong hoäp thoaïi Define Materials taïi 
muïc Materials baïn nhaáp chuoät vaøo CONC, 
trong muïc Click to nhaáp chuoät vaøo Modify / 
Show Material ñeå xuaát hieän hoäp thoaïi 
Material Property Data. 

  

Trong hoäp thoaïi Material Property Data taïi muïc Analysis Property Data baïn tieán 
haønh khai baùo nhö sau : 

• Mass per unit Volume nhaäp vaøo giaù trò : 0  

• Weight per unit Volume baïn nhaäp vaøo giaù trò : 0  

• Modulus of elasticity : 2.65e6  

• Poissons ratio : 0.2 (heä soá poisson). 

• Tieáp theo nhaáp choïn OK ñeå ñoùng hoäp thoaïi Material Property Data. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Define Materials. 
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1. KHAI BAÙO NHÖÕNG ÑAËC TRÖNG VEÀ HÌNH HOÏC  

      Ñoái vôùi baøi toaùn treân goàm boán thaønh phaàn 
ñoù laø C1 : 0.3 X 0.3, C2 : 0.4 X 0.4, D1 : 0.3 X 
0.4, D2 : 0.2 X 0.4. 
� Ñaàu tieân baïn vaøo trình ñôn Define > 

Frame Sections.  

 Hoäp thoaïi Define Frame Sections xuaát hieän : 

� Trong hoäp thoaïi Define Frame 
Sections taïi muïc Click to baïn 
duøng chuoät nhaáp choïn vaøo tam 
giaùc beân phaûi cuûa hoäp Add / 
Wide Flange ñeå choïn Add 
Rectanuglar nhö hình beân döôùi 
ñeå xuaát hieän hoäp thoaïi 
Rectangular Section. 

 

 Hoäp thoaïi Rectangular Section xuaát hieän : 

 

Trong hoäp thoaïi Rectangular Section baïn khai baùo nhö sau : 

• Taïi muïc Section Name baïn nhaäp teân 0303 

• Trong muïc Dimensions nhaäp giaù trò vaøo muïc Depth laø 0.3, vaø muïc Width 
laø 0.3 
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• Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu 
laø CONC. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 
� Baây giôø taïi muïc Click to baïn nhaáp choïn vaøo Add Rectangular. 

 

 Hoäp thoaïi Rectangular Section xuaát hieän. 

 

 Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau : 

• Taïi muïc Section Name baïn nhaäp teân 0404. 

• Trong muïc Dimensions khai baùo tieát dieän cho coät baèng caùch nhaäp giaù trò 
vaøo muïc Depth laø 0.4, vaø muïc Width laø 0.4. 

• Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu 
laø CONC. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 
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� Trong hoäp thoaïi Define Frame 

Sections taïi muïc Name ñaõ xuaát 
hieän hai nhoùm coät vöøa khai baùo 
beân treân, tieáp theo baïn thöïc hieän 
töông töï nhö vaäy ñeå nhaäp kích 
thöôùc cho daàm 0.2 x 0.4, baèng 
caùch nhaáp chuoät vaøo tam giaùc 
beân phaûi ñeå choïn Add 
Rectangular. 

� Trong hoäp thoaïi Rectangular 
Section baïn khai baùo nhö hình 
beân döôùi.  

 
 Tieáp theo thöïc hieän laïi böôùc treân ñeå nhaäp kích thöôùc cho daàm coù tieát dieän 0.3 x 0.4 nhö 
trong hoäp thoaïi sau : 
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� Baây giôø trong hoäp thoaïi Define 

Frame Sections xuaát hieän boán 
nhoùm ñaëc tröng (nhö trong hoäp 
thoaïi beân döôùi). Sau cuøng baïn 
nhaáp choïn Ok ñeå ñoùng hoäp thoaïi 
Define Frame Sections. 

 
 

2. GAÙN ÑAËC TRÖNG VAÄT LIEÄU VAØ TIEÁT DIEÄN CHO PHAÀN TÖÛ 
� Ñeå khai baùo ñaëc tröng cho phaàn töû baïn phaûi khai baùo cho töøng phaàn töû baèng caùch theo 

trình töï sau : 
� Khai baùo cho coät coù cuøng ñaëc tröng C2 : 0.4 X 0.4 laø coät cuûa taàng 1 vaø taàng 2. 

• Treân thanh coâng cuï baïn duøng chuoät nhaáp choïn vaøo bieåu töôïng  sau ñoù 
di chuyeån chuoät vaøo vuøng laøm vieäc nhö hình sau. 

 

 
Baây giôø baïn nhaán giöõ chuoät vaø veõ moät ñöôøng thaúng ngang qua taát caû coät cuûa taàng döôùi 

cuøng vaø thaû nuùt chuoät ra nhö hình sau : 
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Hình khi thaû chuoät 
� Baây giôø baïn goïi leänh Assign > Frame 

> Sections 

 

Hoäp thoaïi Define Frame Sections xuaát hieän : 

 

 Trong hoäp thoaïi Define Frame Sections taïi muïc Name baïn duøng chuoät nhaáp choïn vaøo 
0404 sau ñoù nhaáp choïn OK. 

Chuù yù : Baïn haõy duøng coâng cu Zoom ñeå phoùng lôùn ñoái töôïng, neáu baïn muoán nhìn thaáy tieát dieän 
0.4 x 0.4 xuaát hieän treân coät cuûa taàng 1, sau ñoù baïn phaûi trôû laïi vuøng laøm vieäc ban ñaàu, caùch thöïc 
hieän baïn haõy xem trong phaàn tröôùc. 
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� Tieáp theo baïn gaùn ñaëc tröng vaät lieäu cho coät cuûa taàng 2 baèng caùch choïn coät taàng hai sau 

ñoù thöïc hieän laïi nhö böôùc treân. Keát quaû nhö hình sau. 

 

� Khai baùo cho coät coù cuøng ñaëc tröng C1 : 0.3X 0.4 laø coät cuûa taàng 3 vaø taàng 4. 

Baïn duøng chuoät nhaáp choïn coâng cuï coù bieåu töôïng  sau ñoù di chuyeån vaøo vuøng laøm 
vieäc nhaán giöõ chuoät vaø tieán haønh veõ ñöôøng thaúng nhö hình sau : 
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� Töông töï baïn goïi leänh Assign > Frame > Sections, trong hoäp thoaïi Define Frame 

Sections baïn choïn 0304 sau ñoù nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 

� Khai baùo cho daàm cuûa taàng 1 vaø taàng 2, D1 : 0304 

Nhaán giöõ chuoät vaøo vò trí nhö hình beân döôùi sau ñoù keùo xieân qua phaûi ñeå taïo moät vuøng 
choïn bao phuû toaøn boä daàm taàng 1 vaø thaû chuoät ra. Töông töï nhö treân baïn haõy choïn daàm cuûa 
taàng 2. 

 
Vò trí nhaáp chuoät  

 
Taïo vuøng choïn  
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� Vaøo trình ñôn Assign > Frame > Sections, ñeå xuaát hieän hoäp thoaïi Define Frame 

Sections. 

Trong hoäp thoaïi Define Frame Sections taïi muïc Name baïn duøng chuoät nhaáp choïn vaøo 
0304 vaø nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 
� Khai baùo cho daàm cuûa taàng 3 vaø taàng 4, D1 : 0204 baïn thöïc hieän nhö treân vaø choïn 0204. 

 
Hình khi thöïc hieän xong 
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3. KHAI BAÙO TAÛI TROÏNG 

� Khai baùo tröôøng hôïp tónh taûi  

Ñeå khai baùo tröôøng hôïp tónh taûi ñaàu 
tieân vaøo trình ñôn Define > Static Load 
Cases. 

 

Hoäp thoaïi Define Static Load Case Name xuaát hieän : 

 

Trong hoäp thoaïi 
Define Static Load 
Case Name baïn 
duøng chuoät nhaáp 
choïn vaøo Change 
Load sau ñoù choïn 
OK ñeå ñoùng hoäp 
thoaïi. 

� Khai baùo tröôøng hôïp taïi troïng  

Löïc taäp trung taïi nuùt : 

• Treân thanh coâng cuï baïn duøng Rubber Band Zoom ñeå phoùng lôùn taàng 1, 
baèng caùch nhaáp vaø giöõ chuoät sau ñoù keùo chuoät xieân qua phaûi ñeå taïo moät 
vuøng choïn bao phuû taát caû taàng moät, 

 
• Choïn taát caû caùc nuùt ôû taàng 1 baèng caùch baïn duøng chuoät nhaáp choïn töøøng 

nuùt nhö hình sau. 
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� Baây giôø baïn goïi leänh Assign > Joint Static Loads < Forces. 

 

 Hoäp thoaïi Joint Forces xuaát hieän : 

 

Trong hoäp thoaïi Joint 
Forces taïi muïc Load Case Name 
baïn nhaáp choïn LOAD1, taïi muïc 
Loads baïn nhaäp giaù trò laø –1.5 
vaøo Force Globalz (giaù trò cuûa taûi 
troïng taùc duïng theo phöông truïc 
toång theå Z) sau ñoù nhaáp choïn OK 
ñeå ñoùng hoäp thoaïi Joint Forces. 

 Baïn haõy phoùng lôùn vuøng 
nhìn leân 3 laàn ñeå xem keát quaû. 
Sau ñoù nhôù trôû veå vuøng laøm vieäc 
ban ñaàu caùch thöïc hieän nhö phaàn 
tröôùc. 

 

Taûi troïng ñaõ xuaát hieän treân nuùt cuûa taàng 1 

 Baïn thöïc hieän töông töï cho taàng 2 vaø taàng 3 baèng caùch duøng chuoät nhaáp choïn caùc nuùt cuûa 
hai taàng nhö hình beân döôùi.  

 Chuù yù: Baïn haõy nhaáp choïn chính xaùc vaøo caùc nuùt neáu khoâng seõ khoâng giaûi ñöôïc baøi toaùn , 
trong quaù trình thöïc hieän neáu choïn khoâng ñuùng vaøo nuùt maø baïn caàn choïn thì baïn duøng chuoät 
nhaáp choïn vaøo chính noù. 
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� Baây giôø baïn vaøo trình ñôn Assign > Joint Static Loads < Forces. 

Hoäp thoaïi Joint Forces xuaát hieän : 

 

Trong hoäp thoaïi Joint 
Forces taïi muïc Load Case 
Name baïn nhaáp choïn LOAD1, 
taïi muïc Force Globalz baïn 
nhaäp giaù trò laø –0.8 (giaù trò cuûa 
taûi troïng taùc duïng theo phöông 
truïc toång theå Z) sau ñoù nhaáp 
choïn OK ñeå ñoùng hoäp thoaïi 
Joint Forces. 

 
Hình khi thöïc hieän xong 
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Gaùn löïc taäp trung cho phaàn töû : 

� Tröôùc tieân baïn choïn daàm 
cuûa taàng 1 vaø taàng 2 baèng 
caùch vaøo trình ñôn Select > 
Select > Frame Sections. 

 
 Hoäp thoaïi Select Sections xuaát hieän : 

� Trong hoäp thoaïi Select Sections baïn 
duøng chuoät nhaáp choïn vaøo 0304 vaø 
nhaáp choïn OK. 

 
� Tieáp theo baïn vaøo trình ñôn Assign > Frame Static Load > Point and Unifrom. 

 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 

Trong hoäp thoaïi Point and 
Uniform Span Loads taïi muïc 
Load Case Name baïn duøng 
chuoät nhaáp vaøo tam giaùc beân 
phaûi ñeå choïn LOAD1, sau ñoù 
taïi muïc Uniform Load nhaäp 
vaøo giaù trò –0.8 vaø nhaáp OK ñeå 
ñoùng hoäp thoaïi Point and 
Uniform Span Loads. 
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� Tieáp theo baïn vaøo trình ñôn Select > Select> Labels. 

Hoäp thoaïi Select by Labels xuaát hieän : 

 

Trong hoäp thoaïi Select by Labels taïi muïc 
Element Type baïn nhaáp choïn vaøo tam 
giaùc beân phaûi ñeå choïn Frame, trong muïc 
Select Labels nhaäp vaøo nhöõng giaù trò 
theo trình töï sau: Start Label : 61, End 
Label :81, Increment: 4 

� Baây giôø vaøo trình ñôn Assign > Frame Static Loads  > Point and Uniform. 

 
Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 
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Trong hoäp thoaïi Point and Uniform Span Loads baïn tieán haønh khai baùo nhö sau : 

• Taïi muïc Load Case Name baïn duøng chuoät nhaáp vaøo tam giaùc beân phaûi ñeå 
choïn LOAD1. 

• Nhaáp choïn Forces. 

• Nhaáp chuoät vaøo Absolute Distance from End-I. 

• Trong nuïc Point Loads baïn nhaäp giaù trò nhö sau : 

Distance 1 4 0 0 

Load -0.4 -0.4 0 0 

• Trong muïc Uniform Load nhaäp giaù trò laø 0.0. 

• Nhaáp OK ñeå ñoùng hoäp thoaïi Point and Uniform Span Loads. 

 

Hình khi thöïc hieän hoaøn taát 

� Tieáp theo baïn khai baùo taûi troïng cho daàm cuûa taàng 3 vaø taàng 4 baèng caùch baïn duøng chuoät 
nhaáp choïn vaøo daàm doïc cuûa taàng 3 vaø 4 caùch choïn nhö sau :  

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 184 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

� Tröôùc tieân baïn duøng chuoät nhaáp choïn coâng 
cuï Rubber Band Zoom sau ñoù ñaët chuoät taïi 
vò trí treân cuøng nhö hình sau :  

 

Vò trí nhaáp chuoät 

� Baây giôø nhaáp vaø giöõ chuoät, sau ñoù keùo moät vuøng choïn bao phuû toaøn boä khung cuûa taàng 
3,4 nhö hình sau ñeå phoùng lôùn hai taàng naøy.  

 

Hình khi taïo vuøng choïn 

 
Hình khi thöïc hieän 
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� Tieáp theo baïn duøng chuoät nhaáp choïn vaøo töøng phaàn töû cuûa taàng 1 : 63, 67, 71, 75, 79, 83. 

taàng 2 laø : 64, 68, 72, 76, 80, 84. 

� Vaøo trình ñôn Assign > Frame Static Loads > Point and Uniform  

 

 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 

 Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Uniform Load baïn nhaäp vaøo 
giaù trò laø –0.7 sau ñoù nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 
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� Ñeå trôû laïi vuøng laøm vieäc ban ñaàu baïn 
vaøo trình ñôn View > Restore Full 
View hay nhaán F3 treân baøn phím. 

 

 
Hình khi thöïc hieän xong 

4. KHAI BAÙO BAÄT TÖÏ DO 

� Vaøo trình ñôn Analyze > Set Options 
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 Hoäp thoaïi Analysis Options  xuaát hieän :  

 

 Trong hoäp thoaïi Analysis Options taïi muïc Fast DOFs baïn duøng chuoät nhaáp choïn Space 
Frame (nhö hình con troû chæ beân treân) sau ñoù nhaáp chuoät vaøo Generate Output vaø choïn Select 
Output Options. 

 Hoäp thoaïi Select Output Results xuaát hieän : 

• Trong hoäp thoaïi Select Output Results duøng chuoät nhaáp choïn vaøo 
Displacements ñeå ñöa thoâng soá chuyeån vò taïi nuùt ra file keát quaû, sau ñoù 
nhaáp choïn vaøo Select/ Show Loads ñeå xuaát hieän hoäp thoaïi Select Output. 
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 Trong hoäp thoaïi Select Output baïn nhaáp choïn vaøo LOAD1 Load Case vaø nhaáp OK ñeå 
ñoùng hoäp thoaïi. 

• Nhaäp chuoät vaøo Reaction/ Spring Forces vaø choïn vaøo Select/ Show 
Loads ñeå xuaát hieän hoäp thoaïi Select Output, trong hoäp thoaïi Select 
Output baïn nhaáp choïn vaøo LOAD1 Load Case vaø nhaáp OK ñeå ñoùng hoäp 
thoaïi. 

• Töông töï nhaáp choïn vaøo Frame Forces vaø thöïc hieän laïi böôùc treân. 

• Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output Results. 

5. GIAÛI BAØI TOAÙN 

Ñeå giaûi baøi toaùn baïn vaøo trình ñôn Analyze > Run 
hay duøng F5 treân baøn phím. 

Luùc baáy giôø baïn thaáy xuaát hieän hoäp thoaïi Save 
Model File As. 

 

Trong hoäp thoaïi Save Model File As taïi muïc Save in baïn choïn ñöôøng daãn ñeán thö muïc 
ñeå löu file, taïi muïc File name nhaäp vaøo doøng chöõ”khung khong gian” ñeå ñaët teân cho baøi toaùn. 
Trong muïc Save as type nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn ñònh daïng cho file laø 
(*.SBD). Tieáp theo baïn nhaáp choïn vaøo Save ñeå file ñöôïc löu. 

Luùc baáy giôø maùy seõ 
töï ñoäng giaûi baøi toaùn, khi 
maùy ngöøng giaûi baïn nhaáp 
chuoät vaøo thanh tröôït ñöùng 
beân phaûi (hình muõi teân chæ 
beân döôùi) ñeå kieåm tra keát 
quaû neáu thaáy xuaát hieän 
ERROR baïn phaûi khai 
baùo laïi caùc thoâng soá. Neáu 
khoâng bò loãi maùy seõ xuaát 
hieän doøng chöõ Analysis 
Complete nhö hình sau. 
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Baây giôø baïn nhaáp choïn vaøo OK ñeå xem tröïc tieáp chuyeån vò cuûa khung. 

 
Hình khi chuyeån vò 

6. HIEÅN THÒ CAÙC DÖÕ LIEÄU  

Ñeå xem hieån thò caùc döõ lieäu döôùi daïng baûng baïn vaøo trình ñôn Display > Show Input 
Tabes > Geometry Data 

 
Hoäp thoaïi Display Geometry Options xuaát hieän.  Trong hoäp thoaïi Display Geometry 

Options taïi Geometry Type ñeå ñeå xem döõ lieäu veà nuùt baïn duøng chuoät nhaáp choïn vaøo Joint 
Data, nhaáp choïn vaøo Frame Element Data ñeå xem döõ lieäu veà phaàn töû thanh. 
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Döõ lieäu veà nuùt 

 
Döõ lieäu veà phaàn töû 

7. HIEÅN THÒ NOÄI LÖÏC CUÛA PHAÀN TÖÛ 

Ñeå hieån thò noäi löïc cuûa phaàn töû baïn vaøo trình ñôn Display > Show Element Forces/ 
Stresses > Frames. 
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Hoäp thoaïi Member Force Diagram for Frames xuaát hieän : 

 

 Trong hoäp thoaïi Member Force Diagram for Frames taïi muïc Component baïn duøng 
chuoät nhaáp choïn vaøo Moment 3-3 ñeå xem moment xoaén quanh truïc ñòa phöông 3. 

 
Chuùc möøng baïn thöïc hieän xong baøi taäp khung khoâng gian. 
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BAØI TAÄP 7 

 HEÄ DAÀM GIAO  
 Trong baøi taäp naøy baïn seõ thöïc taäp giaûi moät heä daàm giao nhö hình beân döôùi. 

 

Soá lieäu ban ñaàu  

� Vôùi moâ ñun ñaøn hoài : E = 2.65 106 T/m2. 

� Heä soá Poisson v = 0.18 

� Kích thöôùc cuûa daàm ngang laø 0.25x0.4  

� Kích thöôùc cuûa daàm doïc laø 0.3 x 0.4. 

� Löïc phaân boá treân daàm ngang laø 0.4T/m 

� Löïc phaân boá treân daàm doïc laø 0.5T/m 

� Taûi taäp trung P = 2T, M =0.5Tm 

Ñeå giaûi baøi toaùn daàm giao baïn haõy tieán haønh thöïc hieän qua caùc böôùc sau : 

1. KHÔÛI ÑOÄNG SAP 2000. 

� Töø trình ñôn Start choïn >Programs >SAP 2000NonLinear. 

2. ÑÔN VÒ TÍNH. 

� Khai baùo ñôn vò tính laø Ton-m, baèng caùch baïn duøng chuoät nhaáp choïn vaøo tam 
giaùc beân phaûi phía döôùi cuûa maøn hình vaø choïn Ton-m. 
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3. TAÏO MOÂ HÌNH MAÃU 

� Ñeå taïo moâ hình maãu ñaàu tieân baïn vaøo trình ñôn File > New Model hay baïn duøng 
toå hôïp phím Ctrl + N. 

 
 Hoäp thoaïi Coordinate System Definition xuaát hieän : 

 

Trong hoäp thoaïi Coordinate System 
Definition baïn tieán haønh khai baùo nhö sau :  

9 Nhaáp chuoät vaøo Cartesian  

9 Trong muïc Number of Grid Spaces 
baïn nhaäp vaøo giaù trò nhö sau : 

• X direction : 1   

• Y direction : 1 

• Z direction : 0 

9 Trong muïc Grid Spacing taïi muïc X 
direction nhaäp vaøo giaù trò laø 40, Y 
direction laø : 26, Z direction :1. 

9 Nhaáp choïn vaøo Ok ñeå ñoùng hoäp thoaïi. 

 Khi nhaáp choïn OK maøn hình xuaát hieän hai cöûa soå laøm vieäc nhö hình sau : 

 
 Nhaáp chuoät vaøo cöûa soå beân phaûi ñeå cöûa soå naøy hieän haønh. 
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4. VEÕ DAÀM 

  Ñeå veõ daàm baïn vaøo trình ñôn Draw > 
Draw Frame Element. 

 

 Khi ñoù xuaát hieän bieåu töôïng muõi teân  baïn duøng muõi teân naøy nhaáp choïn moät ñieåm ñaàu 
tieân nhö hình beân döôùi. 

 
 Tieáp theo di chuyeån chuoät leân treân vaø nhaáp ñieåm thöù hai sau ñoù baïn nhaán Esc treân baøn 
phím. 

 
 Nhaáp chuoät vaøo coâng cuï coù bieåu töôïng nhö hình con troû chæ beân döôùi, sau ñoù baïn nhaáp 
vaøo ñieåm ñaàu tieân vaø di chuyeån chuoät sang phaûi ñeå nhaáp choïn ñieåm thöù 3 nhö hình minh hoïa 
sau :  
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Ñeå keát thuùc leänh veõ baïn nhaán Esc treân baøn phím. 

 

Hình khi thöïc hieân xong 

5. SAO CHEÙP NUÙT VAØ PHAÀN TÖÛ 
� Ñeå sao cheùp phaàn töû tröôùc tieân baïn duøng chuoät nhaáp choïn vaøo thanh ñöùng nhö hình con 

troû chæ beân döôùi, sau ñoù baïn vaøo trình ñôn Edit > Replicate hay nhaán toå hôïp phím Ctrl + 
R. 

 

Vò trí nhaáp chuoät 
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Hoäp thoaïi Replicate xuaát hieän : 

 
 Trong hoäp thoaïi Replicate baïn tieán haønh khai baùo theo trình töï sau : 

• Trong muïc Distance baïn nhaäp giaù trò vaøo X = 5, Y = 0, Z = 0. 

• Trong muïc Number nhaäp giaù trò laø 8 . 

• Sau ñoù baïn nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

 
Hình khi thöïc hieän xong 

� Töông töï nhö vaäy baïn duøng chuoät nhaáp choïn vaøo thanh naèm ngang nhö hình con 
troû chæ beân döôùi. 
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  Baây giôø baïn vaøo trình ñôn Edit > 
Replicate ñeå hieån thò hoäp thoaïi Replicate.  

  Hoäp thoaïi Replicate xuaát hieän baïn khai 
baùo caùc thoâng soá nhö sau : 

• Taïi Distance baïn nhaäp vaøo giaù 
trò laø: X = 0, Y = 4, Y = 0 

• Taïi Number nhaäp vaøo giaù trò laø 
2 

        Nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 

 
Hình khi thöïc hieän xong 

� Tieáp theo baïn duøng chuoät nhaáp choïn vaøo thanh thöù 3 tính töø döôùi leân. 

 
Vò trí nhaáp chuoät 
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Baây giôø baïn goïi leänh Edit > Replicate. 

 Hoäp thoaïi Replicate xuaát hieän : 

 

Trong hoäp thoaïi Replicate baïn khai 
baùo caùc thoâng soá nhö sau : 

• Taïi Distance baïn nhaäp vaøo giaù 
trò laø Y = 5 

• Taïi Number nhaäp vaøo giaù trò laø 
2, vaø nhaáp choïn OK. 

 
Hình khi thöïc hieän xong 

� Töông töï nhö treân nhaáp chuoät vaøo thanh thöù 5 (tính töø döôùi leân). 
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� Sau ñoù vaøo trình ñôn Edit > Replicate ñeå xuaát hieän hoäp thoaïi Replicate. Trong 
hoäp thoaïi Replecate baïn nhaäp vaøo giaù trò taïi Y laø 4 vaø nhaáp choïn Ok. 

 

 
Moâ hình daàm giao ñaõ hoaøn taát. 

6. CHIA PHAÀN TÖÛ DAÀM 

      Ñeå chia nhoû phaàn töû tröôùc tieân baïn 
duøng chuoät nhaáp choïn vaøo bieåu töôïng all treân 
thanh coâng cuï.  
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� Tieáp theo baïn goïi leänh Edit > Divide Frame. 

 

 Hoäp thoaïi Divide Selected Frames xuaát hieän : 

 

Trong hoäp thoaïi Divide Selected Frames baïn 
duøng chuoät nhaáp choïn vaøo Break at 
Intersections with selected Frames and 
Joints vaø nhaáp choïn OK ñeå leänh Divide 
Frame ñöôïc thöïc hieän. 

 

Hình khi thöïc hieän xong 

7. KHAI BAÙO ÑIEÀU KIEÄN BIEÂN 

� Ñeå khai baùo ñieàu kieän bieân baïn duøng chuoät nhaáp choïn vaøo hai nuùt bieân ngoaøi 
cuøng beân traùi nhö hình con troû chæ phía döôùi. 
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Baây giôø vaøo trình ñôn Assign > Joint > Restraints. 

 
Hoäp thoaïi Joint Restraints xuaát hieän : 

 

Trong hoäp thoaïi Joint Restraints taïi muïc Fast 
Restraints baïn duøng chuoät nhaáp choïn vaøo Tab 
thöù hai nhö hình con troû chæ beân treân. Sau cuøng 
baïn nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

 Tieáp theo baïn duøng chuoät nhaáp choïn trình töï taát caû nhöõng nuùt coøn laïi nhö hình sau : 

 

THIEÁT KEÁ VÔÙI SÖÏ TRÔÏ GIUÙP CUÛA MAÙY TÍNH                                                                         BIEÂN SOAÏN : TUÛ SAÙCH STK 202 



TÍNH TOAÙN THIEÁT KEÁ KEÁT CAÁU BAÈNG CHÖÔNG TRÌNH SAP 2000 – TÖÏ HOÏC SAP 2000 BAÈNG HÌNH AÛNH 
 

Vaøo trình ñôn Assign > Joint > Restraints. 

Hoäp thoaïi Joint Restraints xuaát hieän : 

 

� Trong hoäp thoaïi Joint 
Restraints taïi muïc Fast 
Restraints baïn duøng chuoät nhaáp 
choïn vaøo Tab thöù ba tính töø traùi 
qua phaûi nhö hình con troû chæ 
beân treân.  

� Sau cuøng baïn nhaáp choïn vaøo 
OK ñeå ñoùng hoäp thoaïi. 

8. KHAI BAÙO CAÙC ÑAËC TRÖNG VAÄT LIEÄU 

� Vaøo trình ñôn Define > Materials ñeå xuaát hieän hoäp thoaïi Define Materials. 

  Hoäp thoaïi Define Materials xuaát hieän : 

 

Trong hoäp thoaïi Define Materials taïi muïc 
Materials baïn nhaáp chuoät vaøo CONC, trong 
muïc Click to nhaáp chuoät vaøo Modify / Show 
Material ñeå xuaát hieän hoäp thoaïi Material 
Property Data. 
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Trong hoäp thoaïi Material Property Data taïi muïc Analysis Property Data baïn tieán 
haønh khai baùo nhö sau : 

• Mass per unit Volume nhaäp vaøo giaù trò : 0  

• Weight per unit Volume baïn nhaäp vaøo giaù trò  : 2.5  

• Modulus of elasticity : 2.65e6  

• Poissons ratio : 0.18 

• Tieáp theo nhaáp choïn OK ñeå ñoùng hoäp thoaïi Material Property Data. 

• Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Materials. 

9. KHAI BAÙO ÑAËC TRÖNG HÌNH HOÏC VAØ GAÙN CHO CAÙC PHAÀN TÖÛ DAÀM 

Ñaëc tröng hình hoïc : 

� Ñaàu tieân baïn vaøo trình ñôn 
Define > Frame Sections. 

 
 Hoäp thoaïi Define Frame Sections xuaát hieän : 

 

Trong hoäp thoaïi Define Frame 
Sections taïi muïc Click to baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân 
phaûi cuûa hoäp Add / Wide Flange ñeå 
choïn Add Rectangular nhö hình 
treân.  

Khi ñoù baïn thaáy xuaát hieän hoäp 
thoaïi Rectangular Section. 

      Hoäp thoaïi Rectangular Section xuaát hieän. 

Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau: 

• Taïi muïc Section Name baïn nhaäp teân D02504 

• Trong muïc Dimensions khai baùo tieát dieän baèng caùch nhaäp giaù trò vaøo muïc Depth laø 
0.25 vaø muïc Width laø 0.4. 

• Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu laø CONC. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 
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Luùc baáy giôø baïn thaáy trong hoäp 
thoaïi Define Frame Sections xuaát hieän 
teân maø baïn vöøa nhaäp vaøo. Tieáp theo baïn 
duøng chuoät nhaáp choïn vaøo tam giaùc beân 
phaûi cuûa muïc Add Rectangular ñeå choïn 
Add Rectangular. 

 

Hoäp thoaïi Rectangular Section xuaát hieän : 
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Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau : 

• Taïi muïc Section Name baïn nhaäp teân N02503 

• Trong muïc Dimensions khai baùo tieát dieän baèng caùch nhaäp giaù trò vaøo muïc 
Depth laø 0.25 vaø muïc Width laø 0.3. 

• Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu laø 
CONC. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 

• Nhaáp Ok ñeå ñoùng hoäp thoaïi Define Frame Sections. 

GAÙN CHO PHAÀN TÖÛ DAÀM : 

� Duøng chuoät nhaáp choïn vaøo coâng cuï coù bieåu töôïng  sau ñoù di chuyeån chuoät vaøo 
vuøng laøm vieäc. 

� Nhaáp vaø giöû chuoät taïi vò trí nhö hình beân döôùi, sau ñoù keùo ñöôøng thaúng qua beân 
phaûi ñeå choïn daàm doïc. 

 
Vò trí nhaáp chuoät 
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 Tieáp theo baïn choïn laïi coâng cuï coù bieåu töôïng  vaø taïo ñöôøng thaúng thöù hai nhö hình 
sau: 

 

 Baïn thöïc hieän töông töï ñeå choïn heát taát caû nhöõng daàm doïc coøn laïi nhö hình beân döôùi. 

 

 Tieáp theo baïn vaøo trình ñôn Assign> Frame > Sections. 
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 Hoäp thoaïi Define Frame Sections xuaát hieän : 

 

Trong hoäp thoaïi Define 
Frame Sections taïi muïc Name baïn 
duøng chuoät nhaáp choïn vaøo D2504 
sau ñoù nhaáp choïn OK. 

 Töông töï nhö treân baïn duøng coâng cuï  ñeå taïo ñöôøng thaúng baèng ngang qua nhöõng daàm 
nhö hình sau : 
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 Tieáp theo baïn vaøo trình ñôn Assign> Frame > Sections.  

Hoäp thoaïi Assign Frame Sections xuaát hieän  

 

 Trong hoäp thoaïi Assign Frame Sections baïn duøng chuoät nhaáp choïn vaøo N02503 vaø nhaáp 
choïn vaøo OK. 

10. KHAI BAÙO TAÛI TROÏNG 

� Ñeå khai baùo taûi troïng ñaàu tieân 
baïn vaøo trình ñôn Define Static 
Load Cases. 

 

 Hoäp thoaïi Define Static Load Case Names xuaát hieän. 

 

 Trong hoäp thoaïi Define Static Load Case Names baïn thöïc hieän khai baùo nhö sau : 

• Taïi muïc Load baïn nhaäp vaøo chuoãi kyù töï TINH TAI, sau ñoù nhaáp chuoät 
vaøo Change Load vaø nhaáp OK ñeå vieäc nhaäp teân ñöôïc thöïc hieän. Nhö 
hình minh hoïa beân döôùi. 
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11. GAÙN TAÛI TROÏNG CHO PHAÀN TÖÛ 

� Taûi troïng taïi nuùt : 

Duøng chuoät nhaáp choïn taát caû caùc nuùt, sau ñoù baïn vaøo trình ñôn Assign > Joint 
Static Loads > Forces. 

 

 Hoäp thoaïi Joint Forces xuaát hieän : 

 

 Trong hoäp thoaïi Joint Forces trong hoäp Loads baïn nhaäp giaù trò laø –2 vaøo Force Global 
Z vaø nhaáp choïn vaøo OK. 

 Tieáp theo baïn duøng chuoät nhaáp choïn 7 nuùt beân phaûi nhö hình beân döôùi. 
 Chuù yù : Vì luùc naøy treân hình xuaát hieän raát nhieàu thaønh phaàn, do vaäy toâi ñaõ thay ñoåi hình 
beân döôùi ñeå baïn deã daøng quan xaùc. 
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Baây giôø baïn goïi leänh Assign > Joint Static Loads > Forces. 

 Hoäp thoaïi Joint Forces xuaát hieän : 

 

 Trong hoäp thoaïi Joint Forces taïi muïc Loads baïn nhaäp giaù trò laø 0.5 vaøo muïc Moment 
Global YY vaø nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

� Khai baùo taûi taùc duïng leân daàm 

Choïn taát caû daàm ngang baèng caùch baïn thöïc hieän töông töï nhö trong phaàn gaùn taûi 
troïng leân daàm. 

�  Sau ñoù baïn vaøo trình ñôn 
Assign > Frame Static Loads > 
Point and Uniform. 
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 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 

 Trong hoäp thoaïi Point and Uniform Span Loads baïn khai baùo theo trình töï sau:
 Ñaàu tieân trong hoäp Load Case Name baïn duøng chuoät nhaáp vaøo tam giaùc beân phaûi ñeå 
choïn TINH TAI, sau ñoù taïi muïc Uniform Load nhaäp vaøo giaù trò –0.4. vaø nhaáp OK ñeå ñoùng hoäp 
thoaïi Point and Uniform Span Loads. 

 Tieáp theo baïn choïn taát caû daàm doïc sau ñoù vaøo trình ñôn Assign > Frame Static Loads > 
Point and Uniform. 

Hoäp thoaïi Point and Uniform Span Loads xuaát hieän. 

 

 Trong hoäp thoaïi Point and Uniform Span Loads taïi Uniform Load baïn nhaäp vaøo giaù trò 
laø –0.5 vaø nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 
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� Khai baùo löïc taäp trung taùc duïng leân daàm thöù 3 (tính töø döôùi leân) baèng caùch baïn di 
chuyeån chuoät vaøo vò trí nhö hình sau : 

 

 Baây giôø nhaáp vaø giöõ chuoät keùo xieân qua phaûi ñeå taïo cöûa soå bao phuû toaøn boä daàm nhö 
hình sau ; 

 

 Vaøo trình ñôn Assign > Frame static Loads > Point and Uniform 
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 Hoäp thoaïi Point and Unifrom Span Loads xuaát hieän : 

 

 Trong hoäp thoaïi Point and Unifrom Span Loads baïn duøng chuoät nhaáp choïn vaøo 
Absolute Distance from End-I, taïi Point Loads baïn khai baùo nhö sau : 

Distance 2 0 0 0 

Load -2 0 0 0 

 Trong muïc Uniform Load baïn nhaäp vaøo giaù trò laø –0.5 vaø nhaáp choïn vaøo OK ñeå ñoùng 
hoäp thoaïi. 

 Töông töï nhö vaäy baïn choïn daàm thöù 4. 

 

Baây giôø baïn vaøo trình ñôn Assign > Frame static Loads > Point and Uniform. 
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 Hoäp thoaïi Point and Unifrom Span Loads xuaát hieän : 

 

 Trong hoäp thoaïi Point and Unifrom Span Loads baïn duøng chuoät nhaáp choïn vaøo 
Absolute Distance from End-I, taïi Point Loads baïn khai baùo nhö sau : 

Distance 3 0 0 0 

Load -2 0 0 0 

 Trong muïc Uniform Load baïn nhaäp vaøo giaù trò laø –0.5 vaø nhaáp choïn vaøo OK ñeå ñoùng 
hoäp thoaïi. 

12. BAÄT TÖÏ DO 

� Ñeå khai baùo baät töï do baïn 
vaøo trình ñôn Analyze > 
Set Options 

� Hoäp thoaïi Analysis Options 
xuaát hieän. 

� Trong hoäp thoaïi Analysis 
Options taïi muïc Fast Dofs 
baïn duøng chuoät nhaáp choïn 
vaøo Plane Grid nhö hình 
con troû chæ trong hình, sau 
ñoù nhaáp choïn vaøo 
Generate Output vaø 
Select Output Options ñeå 
xuaát hieän hoäp thoaïi Select 
Output Results. 
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 Hoäp thoaïi Select Output Results xuaát hieän : 

 

� Trong hoäp thoaïi Select Output Results duøng chuoät nhaáp choïn vaøo 
Displacements ñeå ñöa thoâng soá chuyeån vò taïi nuùt ra file keát quaû, sau ñoù nhaáp 
choïn vaøo Select/ Show Loads ñeå xuaát hieän hoäp thoaïi Select Output. 

 

 Trong hoäp thoaïi Select Output baïn nhaáp choïn vaøo LOAD1 Load Case vaø nhaáp OK ñeå 
ñoùng hoäp thoaïi. 

� Nhaäp chuoät vaøo Reaction/ Spring Forces vaø choïn vaøo Select/ Show Loads ñeå 
xuaát hieän hoäp thoaïi Select Output, trong hoäp thoaïi Select Output baïn nhaáp choïn 
vaøo LOAD1 Load Case vaø nhaáp OK ñeå ñoùng hoäp thoaïi. 

� Töông töï nhaáp choïn vaøo Frame Forces vaø thöïc hieän laïi böôùc treân. 

� Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output Results. 

Tieáp theo baïn vaøo trình ñôn Analyze < Run hay duøng phím F5 treân baøn phím ñeå giaûi baøi 
toaùn. 
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 Khi ñoù baïn thaáy xuaát hieän hoäp thoaïi Save Model File As.  

 

 Trong hoäp thoaïi Save Model File As trong muïc Save in baïn choïn ñöôøng daãn ñeå löu file 
sau ñoù taïi muïc File name baïn nhaäp ñaët teân cho file laø “dam giao” vaø nhaáp choïn Save ñeå vieäc 
löu file ñöôïc thöïc hieän. 

Khi maùy thöïc hieän giaûi xong seõ xuaát hieän hoäp thoaïi coù doøng chöõ Analysis Complete khi 
ñoù baïn nhaáp choïn vaøo OK ñeå xem chuyeån vò. 
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13. XEM KEÁT QUAÛ 

Bieåu ñoà löïc caét 

Ñeå xem bieåu ñoà noäi löïc ñaàu tieân baïn vaøo trình ñôn Display > Show Element Forces/ 
Stresses > Frames. 

 

� Hoäp thoaïi Member Force 
Diagram for Frames xuaát hieän : 

 

 

� Trong hoäp thoaïi Member Force 
Diagram for Frames baïn duøng 
chuoät nhaáp vaøo Shear2-2 vaø 
nhaáp choïn vaøo Fill Diagram. 

 

 
Bieåu ñoà löïc caét 
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 Bieåu ñoà Momen 

�  Töông töï nhö vaäy baïn thöïc 
hieän laïi böôùc treân khi hoäp 
thoaïi Member Force 
Diagram for Frames xuaát 
hieän, baïn duøng chuoät nhaáp 
choïn vaøo Momen 3-3 ñeå xem 
momen xoaén quanh truïc ñòa 
phöông 3 vaø nhaáp choïn vaøo 
OK ñeå ñoùng hoäp thoaïi. 

 

 
Bieåu ñoà Moâment 

14. XEM KEÁT QUAÛ DÖÔÙI DAÏNG BAÛNG 

Ñeå xem döõ lieäu ñaõ nhaáp baïn vaøo trình ñôn Dislpay > Show Input Table > Geometry 
Data. 
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Hoäp thoaïi Display Geometry Options xuaát hieän : 

 

� Trong hoäp thoaïi Display 
Geometry Options taïi muïc 
Geometry Type baïn nhaáp 
chuoät vaøo Joint Data ñeå hieån 
thò döõ lieäu veà nuùt sau ñoù nhaáp 
choïn OK ñeå ñoùng hoäp thoaïi. 

 

 Töông töï nhö treân baïn vaøo trình ñôn 
Dislpay > Show Input Table > Geometry 
Data.  

Trong hoäp thoaïi Display Geometry 
Options baïn nhaáp choïn vaøo Frame Element 
Data vaø choïn OK ñeå xem keát quaû veà phaàn töû. 

 

 

 

  Chuùc möøng baïn ñaõ hoaøn taát baøi taäp naøy. 
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